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Chapter 1. General Outlines of Execution Program
 XE " General Outlines of Execution Program " 
AutoBase software, divided into two programs used for runtime and edit, works interactively with each program. (See <Figure 1-1> below).
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<Figure 1- 1> Entire AutoBase Program Diagram 
1.1 Types of Running Program
Execution programs are run interactively with Monitoring, Communication Server, Network Server / Client, SMS Manager, Line Printer Manager, Watchdog, Running Server, Web Server, etc.  (See <Figure 1-2> below.)
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<Figure 1- 2> AutoBase Running Program Diagram
1.2 System Requirements
The following <Table 1-1> is required in order to set up AutoBase programs.

	SYSTEM
	REQUIREMENTS

	Mainframe  
	IBM-compatible PC, Pentium 4 or above

	OS (Operating System) 
	Microsoft Windows 2000/XP/Server2003 or later

	Main Memory Unit 
	512M or above

	Secondary Memory Unit 
	200MB or above

	Graphic Card 
	Windows Compatible

	Keyboard 
	Windows Compatible

	Mouse  
	Windows Compatible

	Printer 
	Windows Compatible (If necessary)

	Touch Screen 
	Windows Compatible (If necessary)

	Others
	Overlay Board, Camera, Digitizer, Plotter, etc. (If necessary)


<Table 1- 1> AutoBase System Requirements
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Chapter 2. Monitor Program
Monitor Program, the AutoBase main program, is responsible for monitoring, controlling the field status, running script, collecting data, etc.
 XE " Monitor Program " 

 XE " Run Monitor Program " 
2.1 Run Monitor Program
Click on the ‘AutoBase’ ([image: image3.png]


) in the AutoBase Windows or the Start Program to run the monitor program.
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<Figure 2- 1> AutoBase Windows Example
	2.1.1 Using Startup
Registering the monitor program or other required programs in the Startup makes the monitor program run whenever computers start up.

The below <Figure 2-2> is the sample designed to immediately run the monitor program as soon as a computer boots by registering it in the Startup.
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<Figure 2- 2> Example of a monitor program registered in Startup


2.2 Whole Figure and Shortcuts Descriptions 
2.2.1 Whole Figure Descriptions
The <Figure 2-3> below appears by running the monitor program.
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<Figure 2- 3> Initial Screen Example of the Monitor Program
2.2.1.1 Title Bar  XE " Using Start Program " 

 XE " Title Bar " 
Title Bars, the original feature of Windows, display program titles in the upper Windows as shown in <Figure 2-4>.
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<Figure 2- 4> Example of Title Bar
2.2.1.2 Menu Bar  XE " Menu Bar " 
The Menu bar contains File, View, Config Menu, etc.
You are able to select any menus by clicking on the left mouse button after moving the mouse to the Menu you want or using arrow and Enter key with holding ‘Alt’ or ‘F10’.
2.2.1.3 Menu Button  XE " Menu Button " 
The Menu Button shown with Text is located under the scroll bar moving left and right in monitor program.

The Menu Button might be not displayed according to the type of monitor screen and configuration.

2.2.1.4 Windows Internal Area
Internal area of windows, indicating the context of monitor programs, is changeable depending on screen types and editing methods.

2.2.2 Shortcuts Descriptions  XE " Shortcuts " 
You can use the keyboard shortcuts listed below <Table 2-1>.
	SHORTCUTS
	FUNCTIONS

	ENTER
	Select functions and check menus, etc. 

	ESC
	Cancel functions and move back to previous the menu.

	SYMBOL 225 \f "Wingdings",SYMBOL 226 \f "Wingdings",SYMBOL 223 \f "Wingdings",SYMBOL 224 \f "Wingdings" (arrow keys)
	Move the internal Window up/down/ left/ right or between menus. 

	ALT, F10 
	Move to the Menu Bar 

	CTRL+O 
	Log in users. 

	SHIFT+F5  
	Cascade MDI Windows. 

	CTRL+F4
	Close the MDI Window currently selected. 

	Basic Shortcuts for Windows
	Basic functions of Windows shortcuts 

	Others 
	Page Up, Page Down, Home and End Other function keys are available for various uses based on each monitor screen. 


<Table 2- 1> Shortcut Keys Descriptions for the monitor program
2.3 View Menu  XE " View Menu " 
Click on ‘View’ and you will see a drop down box as below <Figure 2-5>.

The menu consists of the following items:  Graphics, Entire tags, Analog inputs and outputs, Digital inputs and outputs, String tags, Registered groups, Alarm Files, Alarm Events, Log Files, Scripts, Communication Server, Reports, Demand Controls, Milli Datas, Schedules, DB Integrations and Navigation.
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<Figure 2- 5> The Drop down box of View Menu
2.3.1 View Graphics  XE " View Graphics " 
As a main feature of the monitor program, Graphics View screen can be differently configured depending on users and work fields.

Click on [image: image9.png]


 on the Graphics screen and then the first screen ‘Startup.Modx’ appears and the screen returns to the previous graphics view with pressing [image: image10.png]


.  Users are able to set in ‘Configuration Settings | Other Settings’ whether to display he Menu buttons below displayed on the bottom of the graphic screen.

The window of the Graphics consists of 2 types, Popup and MDI, installed in the Studio.
	When you click on the right mouse button providing help in the form of a menu of choices at the area neither having graphic elements nor responding to the mouse with graphic elements, the current graphics screen can be enlarged or reduced.
Available to print out the Graphics screen currently being monitored when you choose ‘Print’ in <Figure 2-6>.

The preview screen for graphics is run with pictures drawn in the Studio and users are able to refer to the editing program manuals or ‘Help’ for Studio usage.
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<Figure 2- 6> Shortcuts on View Graphics

	2.3.1.1 Graphic Elements related to Analog  XE " Analog " 


When you move the mouse on graphic elements related to analog, a rectangle appears, once you click it, the menu is changed to the screen connected with analog set in Studio and details concerning selected analog tags are provided.
Additionally, pressing the right button, users are able to change the view menu to the shortcut menu <Figure 2-7>.
Only in case of setting the mouse response to graphic elements in Studio, the rectangle appears.
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<Figure 2- 7> Shortcut Menus for graphic elements related to analog
1) Analog Rectangle  XE " Analog Rectangle " 
This graphic element indicates the rectangle size depending on the current value of analog tags as in the following <Figure 2-8>.  Therefore, the rectangle graphic element is made with length (the current minimum value) and breadth (the max) filled with the specified color from the bottom of the whole shape.
The rectangle graphic elements can select the bar direction such as top to bottom, bottom to top, left to right and right to left.
Available to set the rectangle size, color, location, analog input tags, mouse responses, bar direction of the graphic element for analog rectangles.
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<Figure 2- 8> Method for Realizing the Feature of Analog Rectangle Graphic Element 
(In case of top to bottom of the bar direction)
2) Analog Text  XE " Analog Text " 
Analog text is a graphic element displaying the current value as follows <Figure 2-9>.
Possible to install font, font color, background color, tag titles, font size, display value, etc. in Studio.
You can choose display values in the current and integrated values.
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<Figure 2- 9> The Example of the Graphic Element for Analog Text
3) Analog Meta  XE " Analog Meta " 
The current values are displayed with marked scales as follows <Figure 2-10>.
Analog tags, Meta size, etc. are set in Studio.
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<Figure 2- 10> Example Analog Meta Graphic Element
The current value is displayed at a specific point of the fan shape between the maximum and the minimum.
The graphic element has a similar principle and shape with scales, pressure gauges, ammeters and voltmeters.
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<Figure 2- 11> Method to display values of graphic elements for analog meta
4) Analog Status  XE " Analog Status " 
Specific pictures, animations, etc. are indicated according to the current value of input tags.

The graphic elements are available to install the followings.
	(1)  0 bit, ON
	(12)  B bit, ON
	(23)  6 bit, OFF
	(34)  High or above 

	(2)  1 bit, ON
	(13)  C bit, ON
	(24)  7 bit, OFF
	(35)  Low  or above 

	(3)  2 bit, ON
	(14)  D bit, ON
	(25)  8 bit, OFF
	(36)  LoLo or above 

	(4)  3 bit, ON
	(15)  E bit, ON
	(26)  9 bit, OFF
	(37)  HiHi or below

	(5)  4 bit, ON
	(16)  F bit, ON
	(27)  A bit, OFF
	(38)  High or below

	(6)  5 bit, ON
	(17)  0 bit, OFF
	(28)  B bit, OFF
	(39)  Low  or below

	(7)  6 bit, ON
	(18)  1 bit, OFF
	(29)  C bit, OFF
	(40)  LoLo or below

	(8)  7 bit, ON
	(19)  2 bit, OFF
	(30)  D bit, OFF
	(41)  Normal

	(9)  8 bit, ON
	(20)  3 bit, OFF
	(31)  E bit, OFF
	

	(10)  9 bit, ON
	(21)  4 bit, OFF
	(32)  F bit, OFF
	

	(11)  A bit, ON
	(22)  5 bit, OFF
	(33)  HiHi or above 
	


Graphic elements for the analog status are indicated in the monitor program as one of the following 5 pictures with setting.
If the graphic elements are set such as <Figure 2-12> in Studio, one of the following 5 pictures appears in the monitor program.
(1) Current values are HiHi or above, Red

(2) Current values are High or above, Yellow

(3) Current values are Low or below, Green

(4) Current values are LoLo or below, Blue

(5) Excluding 4 cases, White
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<Figure 2- 12> The example of setting graphic elements for analog status
5) Analog Rotation  XE " Analog Rotation " 
This graphic element displays current analog values using the image rotation angles.
The analog input tags, rotate images, angles and directions, background and background color, whether to respond to the mouse, etc. are set in Studio.

Rotate images used in graphic elements contains two images : default and specific images created by users. For more information how to make rotating images, refer to the user manual for the edit program.

The following <Figure 2-13> is an example of analog rotation graphic element and <Figure 2-14> shows how to display it.
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<Figure 2- 13> Example of Analog Rotation Graphic Element
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<Figure 2- 14> Method to Display Analog Rotation Graphic Element
2.3.1.2 Graphic Elements related to Digital 
The graphic elements connected with digital display animations or bit-map pictures depending on the status ‘ON’ and ‘OFF’ of digital tags including digital animation, circles, rectangles and text. XE " Digital " 
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<Figure 2- 15> Example of Graphic Elements related to Digital
When users place the mouse pointer over the graphic element relevant to digital, the rectangle appears around it as <Figure 2-15>.  Click the left mouse button there, and then the menu displays detailed information of selected digital tags with the related digital screen set in Studio.

	Additionally, if you press the right mouse button on the rectangle image, the shortcut menu appears such as <Figure 2-17>.  Unless you install the mouse response in Studio, no rectangles are displayed despite the mouse point over the graphic element.
The following <Figure 2-16> is the dialog box to confirm output operations appearing in case of choosing to change digital input values.
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<Figure 2- 16> Example of the dialog box
 for changing digital input values 
 XE " change digital input values " 
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<Figure 2- 17> Shortcut Menu for Graphic Elements Related to Digital


1) Digital Animation  XE " Digital Animation " 
<Figure 2-18>, the graphic element, helps users simply verify input values on graphic screen by setting pictures or animation in the event that the digital current values are ON or Off.
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<Figure 2- 18> Example of Graphic Elements for Digital Animation
The status of digital input tag when digital animation is set such as <Figure 2-18>, ‘ON’ of input tag status is shown with the image ([image: image24.jpg]


) or animations and ‘OFF’ is displayed with [image: image25.jpg]


.
Users set digital tags, types of pictures or animation, pictures’ location, etc. in Studio.
<Figure 2-19> showing how to display animations is an animation file created with several images shown alternately at regular intervals (1/18 sec) which looks like a moving image on screen.
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<Figure 2- 19> How to Display Animations
※ Refer to the Editing Program Manual to make animation files. XE "Animation Editor " 
2) Digital Circle  XE " Digital Circle " 
The following graphic screen indicates the circle size, color, etc. set in Studio depending on the status of digital input tags.  <Figure 2-20> is an example of graphic elements for digital circles.
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<Figure 2- 20> Example of graphic element for digital circles
3) Digital Rectangle  XE " Digital Rectangle " 
This graphic element shows the rectangle size and color set in Studio, and the following <Figure 2-21> is an example of digital rectangle elements on screen.
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<Figure 2- 21> Example of graphic elements for Digital Rectangles
4) Digital Text  XE " Digital Text " 
The graphic element of ‘Digital Text’ shows the current values as texts in the followings <Figure 2-22> and the font size and color, font, element locations, digital input tags, etc. are set in Studio.  The text is displayed specified with less than 6 characters (refer to the tag settings) such as ‘ON’, ‘OFF’ or ‘START’, ‘STOP’, etc. in the digital tag property.
[image: image29.jpg]The graphic The graphic
element for element for
digital Text

digital Text

Digital input tag is ‘ON’ Digital input tag is ‘OFF’




<Figure 2- 22> Example of graphic elements for Digital Texts
 XE " button " 
2.3.1.3 Graphic Element related to button 
Graphic elements connected with buttons made up of 4 types such as module selection and hide, script execution and digital print buttons makes it possible to change monitor screen to the installed image module and to implement script, digital group print, etc.
Graphic elements displaying little squares with the mouse on buttons.
When using module hide buttons, the square graphic element appearing with putting your mouse on buttons indicate that the buttons are selected and the monitor screen is moved to the image module by clicking on the left mouse button.  Except for these buttons, you can run functions or specified contents by clicking on the left mouse button on buttons.
1) Module Selection Button  XE "Module Selection Button " 
Several images are used when it is hard to show the entire process with an image to supervise the field by means of changing graphic screens, and users can move them by clicking buttons of module selection and hide and script execution.
Module Selection Buttons displayed like <Figure 2-23> are available to modify the graphic monitor screen to the set image module.
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<Figure 2- 23> Module Selection Button Example
2) Module Hide Button  XE " Module Hide Button " 
Module Hide Buttons having the same feature of Module Selection Buttons are not shown on graphic monitor screen and when users position the mouse on them set in Studio, rectangles are displayed indicating that the module is selected.
<Figure 2-24> is an example showing a selection of Module Hide Buttons.
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<Figure 2- 24> A screen example with a selection of Module Hide Buttons
3) Script Button  XE " Script Button " 
This is to execute the run program or other scripts by displaying buttons on the graphic display as shown <Figure 2-25>.  You can set the size, color, location of the button and the text on it in Studio.
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<Figure 2- 25> Script Button Example
4) Digital Output Button  XE " Digital Output Button " 
Digital output is available on the tag set in Studio making it possible to set the size, color, location, fonts on button, etc. of the digital output button.
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<Figure 2- 26> Digital Output Button Example
When you press digital output buttons (See the <figure 2-26>), the dialog box <Figure 2-27> to check digital output appears.
The number of digital output tags available to be set with the digital output buttons is 1 ~ 32767.
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<Figure 2- 27> Dialog Box to Check Digital Output Button
2.3.1.4 String Tag  XE " String Tag " 
String Tag display assigned strings on graphic monitor screen.  Users are able to set string tag titles, font and background color, whether to respond to the mouse, etc. in Studio.
Possible to change sentences which are going to be displayed in a dialog box manually as the following <Figure 2-28> after setting string tag graphic elements to respond to the mouse and selecting it.
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<Figure 2- 28> Dialog box example for strings change
2.3.1.5 Graphic Module  XE " Graphic Module " 
The graphic element for graphic module is used to monitor several graphic screens on one using created module files as graphic elements.
<Figure 2-29> is an example for graphic monitor screen configured with 5 graphic elements and module selection buttons.
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<Figure 2- 29> Example of Monitor Screen Configured with Graphic Module Element.
2.3.1.6 Alarm Window  XE " Alarm Window" 
Alarm window display on monitor screen specific types of alarms available to be set by selecting ‘During alarms’ or ‘Until users confirm’ on ‘Alarm Priority’ Menu, Studio.
Studio is in charge of setting original titles of alarm window, text size to be displayed, method for arranging alarms, etc.
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<Figure 2- 30> of Monitor Screen Configured with Graphic Module Element
	<Figure 2-30> is a monitor screen example with alarm window and running script for alarm messages, and <Figure 2-31> is a shortcut menu (mouse right button).
In order to confirm or cancel alarm messages indicated on alarm windows, either select menu such as alarm confirmation, etc. on <Figure 2-31> or write a script related to alarms (such as AlarmListConfirm, etc. ).
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<Figure 2- 31> Alarm Window Shorten Menu


2.3.1.7 Multi-graph  XE " Multi-graph " 
Multi-graph show the changes of analog and digital current values for specified times with graphs as the followings <Figure 2-32>.

Analog and digital tags, line color and styles, indicated values, data range, text and its color, class titles, view boundaries, collection cycles, etc. are set in Studio.

Users can install whether set tags are displayed on multi-graph screen or not, if press the left mouse button on a tag property display of graphic elements for multi-graph.

Additionally, available to make sure the maximum, minimum and average values in the changed range, when move the mouse with pressing the left mouse on graph data display.
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<Figure 2- 32> Example Showing Monitor Screen Configured with Graphic Elements for Multi-graph
2.3.1.8 Multi-trend  XE " Multi-trend " 
The multi-trend displays the changes of analog input values (the average, maximum, minimum, integrated, difference values, etc.) or digital operation status for specific minutes, hours, days and months.
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<Figure 2- 33> Example Displaying Monitor Screen Configured with Graphic Elements for Multi-trend
Users are able to set analog and digital tags, line color and styles, indicated values, time range, text and its color, graph names, etc. for multi-trend in Studio.
The Settings dialog box such as <Figure 2-34> available to install trend length, graph start time, etc. appears if click the left mouse button outside the data display of graphic elements for multi-trend.

Moreover, if press the right mouse button and move the mouse, time for data moves as much as the extent the mouse does, and also possible to see the maximum, minimum and average values in the changed range, once move the mouse with pressing the left mouse.
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<Figure 2- 34> Multi-trend Setting Dialog Box in Monitor Program
After checking ‘Use local ranges’ in the settings dialog box <Figure 2-34>, if you click the right mouse button inside multi-trend maximum and minimum values display area, the dialog box <Figure 2-35> able to regulate the multi-trend graph range comes up.
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<Figure 2- 35> Graph Range Setting Dialog Box Example
Press the left mouse button on each multi-tag name, maximum, minimum, current and data value area, you can check whether the selected tags are displayed or not, and change them to the standard tags with clicking the right mouse button.
2.3.1.9 Demand Window  XE " Demand Window " 
Demand Window, one of graphic elements, to indicate the demand controls status as graph is usually used to analyze flow and a quantity of electric power for 15 minutes. 

Tags used for power input, estimated power display, target power, cutoff and control and control time, text, background color, etc. is set in Studio. The following <Figure 2-36> is an example of graphic elements for demand window and <Figure 2-37> is about Display Principle for Demand Window.
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<Figure 2- 36> Example of Graphic Elements for Demand Window
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<Figure 2- 37> Display Principle of Graphic Elements for Demand Window
2.3.1.10 Milli-Data Window XE " Milli-Data Window " 
The milli-data window collects the set analog and digital tag at intervals of 1 to 60,000 msec and displays such as the following <Figure 2-38> using MDB data format.

The upper window of milli-data windows shows all gathered data, and the lower one indicates the data values selected on the upper.
Users make it possible to select area to display on the lower window by pressing and holding the left mouse button, then moving it.
Available to set data tag, data intervals, collection conditions, display text and it color, etc. in Studio.  Also, users are able to choose display data and install the display method of time axis for micro data window with writing script such as MilliDataSetFile and MilliDataSetTimeType in Studio.
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<Figure 2- 38> Example of Graphic Elements for Milli-Data Window
2.3.1.11 Graphic Element related to Window Control. 
Window Control used for windows such as List Box, Combo Box, Edit Box, Radio Button and Check Box is a component to configure graphic monitor screen.
 XE " Window Control " 
	1) List Box  XE " List Box" 
This is to display lists such as <Figure 2-39> on graphic screen and data, related tags, text, display format, etc. are set in Studio.
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<Figure 2- 39> Example of Graphic Element for List Box

	2) Combo Box 
This is to show combo box like <Figure 2-40> on Graphic Screen and Studio is responsible for setting data, relevant tags, text, display format, etc.
 XE " Combo Box " 
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<Figure 2- 40> Example of Graphic Elements for Combo Box

	3) Edit Box 
This is to indicate Edit Box as an example <Figure 2-41> and available to install connected tags, text, etc. in Studio.
 XE " Edit Box " 
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<Figure 2- 41> Example of Graphic Elements for Edit Box

	4) Radio Button 
This is to display radio buttons such as <Figure 2-42> and item data, relevant tags, text and it color, etc. are set in Studio.
 XE " Radio Button " 
 XE " Check Box " 
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<Figure 2- 42> Example of Graphic Element for Radio Button

	5) Check Box 
This shows check boxes on Graphic Screen and tags, display contents, text and its color, etc. installed in Studio.
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<Figure 2- 43> Example of Graphic Elements for Check Box


2.3.1.12 Database
Database displays database data for example Access (MDB format), SQL Server, Oracle, etc. as the same format of <Figure 2-44>. XE " Database " 
Database types, text and its color, etc. are set in Studio.
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<Figure 2- 44> Example of Graphic Elements for Database
The following <Figure 2-45>, a setting dialog box for a database element available to install column names, display text, start point and whether, display or not, etc.  You are able to select it by clicking the right mouse button on the database element.
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<Figure 2- 45> Example of Dialog Box for Database Column
2.3.1.13 Real-time Test Graph 
Real-time test graph is to display the change of specific tag values for set time with graph.
The graph with dots on the following <Figure 2-46> indicates standard tag values.
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<Figure 2- 46> Example of real-time test graph
The base tag is used to check out how close the actual values are to the standard one by inputting changing values such as temperature, pressure and so on when running.  You can set the base and actual tag, color and font of the real-time graph in Studio.
 XE " Real-time Test Graph " 
2.3.1.14 XY Graph
This XY Graph is to see the changes of current values for a couple of tags for set time as the followings <Figure 2-47>. XE " XY Graph " 
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<Figure 2- 47> Example of XY Graph
The view range is 1 to 10,000, and data collection intervals are 1 to 60,000 msec.
Studio is responsible for the number of components, collection intervals, graph components, font and is color, etc.
2.3.1.15 Database Trend
This displays data stored with time in database such as <Figure 2-48> using trend format, graphic element. User are able to install database types, table names, data time format, column, analog and digital tags connected with column, line color and styles, display values, time range, font and it color, graph names, etc. in Studio.  XE " Database Trend " 
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<Figure 2- 48> Example of monitor screen with the graphic element for database
Click on the left mouse button outside of display of graphic elements on monitor screen, the settings dialog box such as <Figure 2-49> appears.
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<Figure 2- 49> Settings Dialog Box of Database Trend on Monitor Program
Press the right mouse button on display area showing the maximum and minimum for database trend and then you can control the graph ranges after checking ‘Use local ranges’ on <Figure 2-49>.
Additionally, users can decide whether selected tags are displayed or not if push the left mouse button on tag names, maximum, minimum, current values and data values for each database trend as well as alter the chosen tags to standard ones with clicking on the right mouse button.
2.3.1.16 Display Changes
 XE " Display Changes " ‘Display Changes’ is a graphic element to indicate the current analog input values and the tags changed with digital input status.
Users are able to set the list numbers (1~100) of graphic elements to display changes, font and background colors, fonts, class names, extensions, etc.
2.3.1.17 Bitmap  XE " Images " 

 XE "Bitmap " 
This graphic element showing bitmap images commonly use smaller images than background ones.
<Figure 2-50> is an example of graphic screen by inserting bitmap image files on the background.

Users are able to connect pictures to tags using extensions or make them move, reduce, enlarge, etc.
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<Figure 2- 50> Example displaying graphic elements inserted on background picture
2.3.1.18 Animation  XE " Animation " 
This element is to show animated pictures on graphic screen. Animation types and locations are specified in Studio.
The upper picture of <Figure 2-51> is that animation elements are inserted on graphic monitor screen, and the lower is to display one of the animated picture files.  XE "Time interval" 
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<Figure 2- 51> Example of Inserted Animation
That is, the upper picture looks like it actually moves by showing 5 images on the lower screen in rotation at regular intervals. (Setting in animation editors or extension scripts)  You are able to connect animation to tags or operate it for animation speed, movement, reduction, enlargement, etc. using extensions.
2.3.1.19 Single line text  XE " Single line text " 
Text is indicated on graphic screen as the followings <Figure 2-52>, and font types, size, color, location, etc. are set in Studio.

Text elements consist of ‘Single line text’ and ‘text’, and text size, style, location, etc. can be changed using extension.
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<Figure 2- 52> Example of a Text Element
2.3.1.20 Rectangle  XE " Rectangle " 
This element is to show rectangle and button shapes on graphic screen, and Studio is responsible for setting rectangle size, stroke thickness, shapes (rectangles or buttons), locations, extensions, etc.
The following <Figure 2-53> is an example of rectangle elements based on setting.
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<Figure 2- 53> Example of rectangle elements depending on setting
2.3.1.21 Circle  XE " Circle " 
Circles are displayed on graphic screen such as <Figure 2-54>, and the size, stroke thickness, location, extension, etc. are installed in Studio.  This element can connected to tags, or operated for animation speed, movement, reduction, enlargement, etc. using extensions.
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<Figure 2- 54> Example of Circle element based on setting
2.3.1.22 Line  XE " Line " 
<Figure 2-55> is an example to indicate lines on graphic screen and the line length, thickness, locations, extensions, etc. are set in Studio.
It is possible to connect to tags or move, reduce, enlarge the graphic elements using extensions.
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<Figure 2- 55> Graphic Element Example of the Line Based On Setting
2.3.1.23 Polygon  XE " Polygon " 
<Figure 2-56> below is to show polygon elements and the shapes, size, locations, stroke thickness, extensions, etc. are installed in Studio.
Moving, reducing, and enlarging the graphic element representing polygons are available.
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<Figure 2- 56> Graphic Element Example of the Polygon Based On Setting
 XE " Rounded Rectangle " 
2.3.1.24 Rounded Rectangle
Rectangles with Rounded Corners which has same features with normal rectangles except for outer forms can be displayed on graphic screen with setting the shapes, size, locations, stroke thickness, extensions, etc. in Studio.
2.3.1.25 Curve  XE " Curve " 
This element indicate curves and the shape, size, locations, line thickness, extensions are set in Studio.
2.3.1.26 Clock  XE " Clock " 
Clock elements show the current time including analog and digital display forms such as <Figure 2-57> on graphic screen, and also users can customize the locations, size and color in Studio.
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<Figure 2- 57> Graphic Element Example of the Clock
2.3.1.27 Date  XE " Date " 
This graphic element indicates the current date, and the location, size, color, etc. are set in Studio.  The following <Figure 2-58> is an example of showing dates and has several options to select, for instance ‘disable the display of days’, ‘Korean or English’, ‘year/month/day or year/month/day’ for date display.
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<Figure 2- 58> Graphic Element Example of Date
2.3.1.28 Background BitmapXE " Background Bitmap "
Bitmap images are used for the background of graphic module screen, and uses are able to install background ones in Studio.
2.3.1.29 Background Color XE " Background Color "
Picture areas except for buttons, analog or digital graphic elements, background pictures, etc. are filled with background color set in Studio.
2.3.1.30 Group XE " Group "
The group is made as a graphic element by putting analog or digital graphic elements, rectangles, circles, straight line, etc. together. It is available in only Studio, and graphic elements runs independently in graphic monitor.
2.3.1.31 Extension of Graphic Element 
Most graphic elements have extension such as size, mouse responses, view, color, etc. available by writing script.  For more details on how to write scripts for the extensions, refer to the instruction of the editing program. XE " Extension of Graphic Element "

 XE "Script" 
2.3.2 Entire Tags  XE " Entire Tags " 
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<Figure 2- 59> Example of View Screen for Entire Tags
View screen for all tags such as <Figure 2-59> appear with selecting ‘View | Entire tags’ in text menu.
Entire tags view is able to monitor or control all tag values and setting status for example analog input and output, digital input and output, strings and group tags, etc.
As an example of <Figure 2-59> above, on the left side of entire tags view displays trees for group, and the right is for tag names belonging to each group, explanation, current values, setting status, etc.
	After selecting the first tree (Local) of entire tags view, press the right mouse button, and then a shortcut menu such as <Figure 5-60> appears. A setting dialog box comes up by choosing ‘Tags View Settings’.
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<Figure 2- 60> First Tree Shortcut Menu of Entire tags view
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<Figure 2- 61> Dialog Box to Set ‘Tags View Settings’
	Tags for all groups are displayed on the first tree with checking ‘Display all tags on the root tree’ in the <Figure 2-61>.
Press the right mouse button on the right tag list of all tag view, and then available to run shortcut menu as indicated <Figure 2-62> or a detailed monitor, settings, etc. with the menu button on the bottom of the screen.
If double-click the left mouse button on the tag list, it is moved to a detailed monitor screen for each tag.
Able to move to a detailed monitor screen with selecting  ‘Detail View’ on the short menu for all tag view list or 
[image: image69.png]Detai[Ent]



 on the menu button.
Group tag is transferred to the screen to select the subgroup, and string tags open the dialog box available to modify tag properties.
Select ‘analog input’, ‘analog output’, ‘digital input’, ‘digital output’, ‘string tag’ on the shortcut menu of all tag view list, and then possible to choose tag monitor screen for each tag of Chapter 2.3.3 ~ 2.3.7.

Other shortcut menus and menu buttons for all tag view have the same way of using shortcut menus and buttons for analog, digital, and string monitor screen.
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<Figure 2- 62> Shortcut menu
for all tag view list


2.3.3 Analog Inputs  XE " Analog Inputs " 
When you select ‘View | Analog Inputs’ in text menu, the analog input view screen as followed <Figure 2-63> appears which displays tags, explanation, current values, setting status. etc. and modifies tag contents.
Double click 
[image: image71.png]Detai[Ent]



 from the menu, ‘Analog Input Detail’ from the shortcut menu, or the left mouse button of the selected tags, available to move to Detail View of analog input. 

For more details about the Detail View, refer to chapter 2.3.3.1.
Analog Trend Diagnosis Screen comes up if choose [image: image72.png]Trend[F4]



 from Menu or ‘Analog Trend Diagnosis’ from the shortcut menu, and details concerning this are explained in chapter 2.3.3.2.
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<Figure 2- 63> Example of Analog Inputs View
The screen is moved to analog data view by clicking [image: image74.png]Data[F6]



 from menu or Analog Data View from shortcut menu.
Refer to the chapter 2.3.3.3 for more information about analog data view.
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 from menu are to set whether to use alarms, data and tags for selected analog input tag.
	A shortcut menu appears (see <Figure 2-64>) when you click the right mouse button on the selected list of analog input view.
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<Figure 2- 64> Shortcut Menu of ‘View Analog Input’


The properties of Analog input tag can be changed in the dialog box such as <Figure 2-65> by selecting [image: image79.png]Tag[F11]



 from menu or ‘Tag Properties’ from shortcut menu.
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<Figure 2- 65> Dialog Box to Tag Properties of Analog Input Tag
Users are able to set alarm levels of analog input tags such as HiHi, High, Low, LoLo in the dialog box as followed <Figure 2-66> with selecting [image: image81.png]


 from Menu.
[image: image82.png]Alarm Level Setting





<Figure 2- 66> Dialog Box for Analog Alarm Level Settings
Analog set points are able to be changed in the dialog box such as <Figure 2-67> by choosing ‘Change &Value’ from the shortcut menu for Analog Input View. The tag property set with either memory tags or AO and SV factors is required to change analog set points.
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<Figure 2- 67> Dialog Box to Change Analog Set Points
For manual input settings, click on ‘Set Temporary Value’ functioning the current values of specific tags to fix random values.
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<Figure 2- 68> Example of Dialog Box for Analog Temporary Value
Users can find tags what they want, when inputting tag names or sequence numbers to find in the dialog box <Figure 2-69> by selecting ‘Tag Search’ from the shortcut menu.
Color of background, text, tag, explanation and font, font size, etc. are available to be set by choosing Text Menu from Configuration.
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<Figure 2- 69> Dialog Box to Find Tags Using Tag Name or Position
2.3.3.1 Analog Input Details  XE " Analog Input Details " 
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<Figure 2- 70> Detail View Example of Analog Input
Analog input details possible to be moved from graphic elements and scripts connected with View of Analog Input, Entire Tags, Registered Groups, etc. show real- time trend diagnosis for analog input values and set points as above <Figure 2-70>.
	Simply clicking the right mouse button on Detail View can bring up a shortcut menu such as <Figure 2-71>.
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<Figure 2- 71> Shortcut Menu of 

Detailed View Screen of Analog


Select [image: image88.png]Setting[F3]



 from the menu bar or ‘View Settings’ in the shortcut menu, the dialog box for detail view settings as below <Figure 2-72> appears.
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<Figure 2- 72> Example of Dialog Box to set Analog Input Detailed View
To move to the analog trend diagnosis screen, click on [image: image90.png]1HourFé]
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, [image: image95.png]30Day[F12]



 from menu buttons or ‘Analog Trend for 1 Hour ~ Analog Trend for 30 Days’ in the shortcut menu. Chapter 2.3.3.2 will explain analog trend diagnosis.
Analog Data View will open by pressing ‘Analog Minutely Data ~ Analog Monthly Data’. For more details, refer to chapter 2.3.3.3.
Users can change the set points using ‘Change Value’ and tag properties by selecting ‘Tag Properties’.
It is possible to fix analog current values as random values when click on ‘Set Temporary Value’ in the shortcut menu, and also to display details about previous and next tag using Page Up or Page Down keys on Analog Detail View Screen.
Background and text color, font and its size, etc. are set in Font or Color from Text Menu in the configuration menu.
2.3.3.2 Analog Trend Diagnosis  XE " Analog Trend Diagnosis " 
This trend diagnosis for 1, 8, 24, 48 hours and 30 days shows the flow of input values such as <Figure 2-73> using saved minute data.
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<Figure 2- 73> Example of Analog Trend Diagnosis.
	This screen can be transferred from Analog Inputs, Entier Tags and Registered Groups, Analog Details and Data View, graphic elements and scripts relating to Analog, etc.
Press the right mouse button on the Analog Trend Diagnosis Screen, and then the shortcut menu <Figure 2-74> comes up.

The trend diagnosis data can be displayed with the order such as average → minimum → maximum → integration → total by pressing [image: image97.png]Average[F2]



 from the menu button.
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<Figure 2- 74> Shortcut Menu for Analog Trend Diagnosis Screen


Settings for Max / Min in Trend Diagnosis, Data Reading Interval, View Method, Start Time for Data View, etc. is available in a dialog box for Analog Trend Diagnosis Settings as below <Figure 2-75> by choosing Settings one of [image: image99.png]Setting[F3]



 and [image: image100.png]Period: 1Min



 from menu buttons or ‘View Settings’ in the shortcut menu.
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<Figure 2- 75> Dialog Box to Set Analog Trend Diagnosis
Selecting Time Change [image: image102.png]Time[F12]



 from menu buttons is possible to change Start Time for Data View. You are able to confirm current values by selecting either [image: image103.png]Dat:




 or [image: image104.png]Data+{End]



 and to increase or decrease the Start Time for Data View by 1/8/24/48/72 hour or 30 day in case of clicking on [image: image105.png]


, [image: image106.png]Time-+[+]



, [image: image107.png]1/918:00



 or [image: image108.png]1/913:00



.
Moreover, choosing ‘Analog Trend for 1 Hour ~ 30 Days’ can make trend diagnosis time change.
Analog Data View appears after selecting ‘Analog Minutely Data ~ Analog Monthly Data’ and you will look at the details in chapter 2.3.3.3.
Analog set points and tag property can be changed using ‘Change Value’ or ‘Tag Properties’.
‘Set Temporary Value’ features to fix current values for specific tags as random values.

Pressing Page Up or Page Down displays previous or next tag for analog input on the trend diagnosis screen. The background and text color, font and the size, etc. are installed in Font or Color from text menu in configuration menu.
Multi Trend Diagnosis showing several analog tags using script functions, etc. comes up when writing scripts below in script run button from Studio.
@MultiRegister("PTE_AHU1", 127, 2);

@MultiRegister("PTE_AHU2", @RGB(0, 127, 0), 1);

@MultiRegister("PHE_AHU1", 0, 3);

@SetBackColor(@RGB(255, 255, 255));

@MultiTrend(1);

Explanations : The monitor screen opens about analog trend diagnosis for 1 hour (3 diagnosis at the same time) with 3 tags for PTE_AHU1, PTE_AHU2, PHE_AHU1 and white background. (Refer to the edit program manual) 

2.3.3.3 Analog Data View  XE " Analog Data View " 
Analog Data View using numbers of graphs to indicate data for each minute, hour, day, week and month as below <Figure 2-76> can be moved from Analog Inputs, Entire Tags, Registered Groups, analog details and trend diagnosis, graphic elements and script connected with analog.
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<Figure 2- 76> Example of Analog Data View Screen
	When you click on the right mouse button on analog data view, the shortcut menu such as <Figure 2-77> appears.
Choosing [image: image110.png]Average[F2]



 is available to show trend diagnosis data with the changed order such as average → minimum → maximum → integration → total.
Users are able to modify settings for maximum and minimum in Trend Diagnosis, view type, display time in graph, integrated value, etc. in the dialog box such as <Figure 2-78>, if click on [image: image111.png]Setting[F3]



 from the menu buttons or ‘View Settings’ in the shortcut menu.
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<Figure 2- 77> Shortcut Menu 

to View Analog Data
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<Figure 2- 78> Example of Dialog Box for Analog Data View Settings
Data view with the order (minutely → hourly → daily → weekly → monthly) can be displayed when selecting [image: image114.png]Data[F4]



 from menu buttons.
Users can change analog data view display method into the sequence (numbers → line graph → bar graph) when selecting [image: image115.png]Display[F11]



 from menu buttons.
Choosing [image: image116.png]Time[F12]



 can make Start Time for Data View change, and also the time is increased or decrease using [image: image117.png]Time-+[+]



 and [image: image118.png]


.
Analog Trend Diagnosis comes up by pressing one of ‘Analog Trend for 1 hour ~ 30 Days’ and refer to chapter 2.3.3.2 for more details.

Analog data view time is modified by clicking on ‘Analog Minutely Data ~ Monthly Data’.
Users can change the set points using ‘Change Value’ and tag properties by selecting ‘Tag Properties’.
Clicking on ‘Set Temporary Value’ from the shortcut menu can make the current value fix as random values.
Clicking on Page Up or Page Down displays previous or next tag for analog input on the analog data view screen.
The background and text color, font and the size, etc. are set in Font or Color from text menu in configuration menu.

Analog multi data view displaying data concerning several tags using script functions, etc. is written as below.

@MultiRegister("PTE_AHU1", 127, 0);

@MultiRegister("PTE_AHU2", @RGB(0, 127, 0), 1);

@MultiRegister("PHE_AHU1", 0, 3);

@MultiRegister("PHE_AHU2", @RGB(127, 127, 0), 5);

@SetBackColor(@RGB(255, 255, 255));

@MultiData(0, 2);

Explanations : Data view with 4 line graphs are run at the same time along with 4 tags such as PTE_AHU1, PTE_AHU2, PHE_AHU1, PHE_AHU2 and white background. (Refer to the edit program manual)
2.3.4 Analog Outputs  XE " Analog Outputs " 
Select ‘View | Analog Outputs’ from the Text Menu, and then the analog output view (See <Figure 2-79>) appears.
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<Figure 2- 79> Example of Analog Outputs View
	Analog Output View is the screen available to display all tag names for output tag, tag explanations, current values, setting status, etc. and modify tag contents.

	Double click on the right mouse button on the selected list from analog output view screen to view the shortcut menu such as <Figure 2-80>.
Screens move to the Analog Output Detail View by pressing [image: image120.png]DetailEnt]



 or double clicking on ‘Analog Output Detail’ from shortcut menu. For more details, refer to chapter 2.3.4.1.
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<Figure 2- 80> Shortcut Menu 
for Analog Output View


By choosing [image: image122.png]Output[F3]



 buttons or ‘Change Value’ from the shortcut menu, it makes it possible to output setting values for analog output tag in the dialog box as below <Figure 2-81>.

The button [image: image123.png]Active[Fa]



 from menu is to install whether to use selected tag or not.
Clicking on the button [image: image124.png]Tag[F11]



 or ‘Tag Properties’ makes it possible to change properties for analog output tags in the dialog box as following <Figure 2-82>.
[image: image125.png]Analog Output Change Value

[ Output Tag
TAG  SHEOAHUL
Desc  AHUL Humid SV

et vae
=





<Figure 2- 81> Dialog Box to Change Analog Output Values
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<Figure 2- 82> Dialog Box to Change the Tag Property of the Analog Output
2.3.4.1 Analog Output Details  XE " Analog Output Details " 
Analog Output Details indicating real- time trend diagnosis and set points for analog output current values as below <Figure 2-83> can be moved from Analog Outputs, Entire Tags, Registered Groups, scripts, etc.
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<Figure 2- 83> Example for Analog Output Details
	By clicking on the right side button on a mouse, the shortcut menu <Figure 2-84> comes up.
Selecting [image: image128.png]Output[F3]



 button from the Menu or ‘Change Value’ in the shortcut menu can make points installed for analog output tag in the dialog box <Figure 2-81> output.
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<Figure 2- 84> Shortcut Menu 
for Analog Output Detail View


Tag properties are changeable in case of choosing ‘Tag Properties’ button.

The Detail View Screen of previous and next tag for analog output opens using Page Up or Page Down on Analog Output Detail View Screen.
Background and text color, font and its size, etc. on the output detail view screen are installed in Font or Color buttons from Text Menu of Configuration.
2.3.5 Digital Inputs  XE " Digital Inputs " 
To display Digital Inputs View screen as below <Figure 2-85> indicating tags explanations, current values, settings status, etc. for all digital input tags, select ‘View | Digital Inputs’ from the Text Menu.
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<Figure 2- 85> Digital Inputs View
	Press the right side button on a mouse on the selected list from Digital Inputs View, the shortcut menu <Figure 2-86> appears.
To move to Digital Input Detail View, choose [image: image131.png]DetailEnt]



, or double click on the left side of a mouse in the selected tag. For more information for use, refer to chapter 2.3.5.1.
Digital input values in the dialog box (See <Figure 2-87>) are changeable via [image: image132.png]Output[F3]



 or ‘Change Value’ buttons requiring memory tags for properties or Out1, Out2 set.
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<Figure 2- 86> Shortcut Menu 

for the View Screen of Digital Input

	Digital Trend Diagnosis is displayed when select [image: image134.png]Trend[F4]



 button or one of ‘Digital Trend for 1 Hour ~ 30 Days’, and chapter 2.3.5.2 includes more explanations.
The way to show digital data view is clicking [image: image135.png]Data[F6]



 or one of ‘Digital Minutely Data ~ Monthly Data’ and more details are in chapter 2.3.5.3.
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<Figure 2- 87> Example of Dialog Box 
for Digital Input Value Change
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 from menu are to set whether to use alarms, data and tags for selected digital input tag.
Users are able to change the property for digital input tag in <Figure 2-88> using ‘Tag Properties’ or [image: image140.png]Tag[F11]



 from the menu buttons.
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<Figure 2- 88> Example of Dialog Box for Digital Input Tag Property Change
Current values of Digital Input Tags can be settled as random values when selecting ‘Set Temporary Value’ in <Figure 2-89>.
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<Figure 2- 89> Example of Dialog Box for Manual Digital Input
Inputting tag names or sequence numbers with choosing ‘Tag Search’ make users possible to find tags that they want.

Users can install color of background, text, tag, explanation and font, its size, etc. in Font and Color from Configuration Menu.

2.3.5.1 Digital Input Details  XE " Digital Input Details" 
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<Figure 2- 90> Example of Digital Input Details View
	Digital Input Details display real–time trend diagnosis of current values for digital input and set points, etc. as below <Figure 2-90> and can be moved from View Screen for digital input, entire tag, registered group as well as graphic elements and scripts relating to digital.

Shortcut Menu such as <Figure 2-91> comes up by clicking on the right mouse button on this screen and <Figure 2-92> appears using [image: image144.png]Setting[F2]



 or ‘View Settings’.
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<Figure 2- 91> Shortcut Menu 

for the Detailed View Screen of Digital
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<Figure 2- 92> Dialog Box to Set the Detailed View of Digital Input
The current values for digital input can be changed with choosing [image: image147.png]Output[F3]



 or ‘Change Value’.
Screens move to the Digital Trend Diagnosis when pressing one of [image: image148.png]1HourFé]



, [image: image149.png]BHour[F7]



, [image: image150.png]24Hour[Fa]



, [image: image151.png]48hour[Fa]



, [image: image152.png]72HourF11]



, [image: image153.png]30Day[F12]



 or ‘Digital Trend for 1 Hour’ ~ ‘or 30 Days’ from the shortcut menu. Chapter 2.3.5.2 has more details.
Digital Data View is moved by clicking on ‘Digital Minutely Data’ ~ ‘Digital Monthly Data View’ on the shortcut menu and chapter 2.3.5.3 includes details.
Tag properties are changeable in case of choosing ‘Tag Propertites’ Change button.

Clicking on ‘Set Temporary Value’ from the shortcut menu can make the current value fix as random values. Hitting Page Up or Page Down displays previous and next tag for digital input on Digital Data View.
The background color, font, font color and size, etc. of the detailed view screen are set in Font and Color from sub menus in Configuration Menu.
2.3.5.2 Digital Trend Diagnosis  XE " Digital Trend Diagnosis " 
This displays the flow of digital input values such as <Figure 2-93> using saved minute data and includes several screens for example 1, 8, 24, 48 , 72 hours and 30 days trend diagnosis available to be moved from View Screen for digital input, entire tag, registered group as well as graphic elements and scripts relating to digital.
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<Figure 2- 93> Example of Digital Trend Diagnosis
	The shortcut menu <Figure 2-94> comes up by clicking on the right side of the mouse on the screen.
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<Figure 2- 94> Shortcut Menu of Digital Trend Screen


Setting up data reading interval, data view, trend diagnosis start time, etc. is available in the dialog box <Figure 2-95> using [image: image156.png]Setting[F3]



, [image: image157.png]Period:01Min



Data Intervals:1min from menu buttons or ‘View Settings’ from the shortcut menu.
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<Figure 2- 95> Example of Dialog Box for Digital Trend Settings
Choosing [image: image159.png]Time[F12]



 can change data view start time.
Users are able to check current values out by selecting [image: image160.png]Dat:




, [image: image161.png]Data+{End]



 and change data view start time using [image: image162.png]


, [image: image163.png]Time-+[+]



, [image: image164.png]1/1010:00



 or [image: image165.png]1/1011:00



 from the menu buttons.
Time for Digital Trend Diagnosis View is possible to be changed by pressing one of ‘Digital Trend for 1 Hour ~ Digital Trend for 30 Days’.
Digital Data View is moved by clicking on ‘Digital Minutely Data ~ Digital Monthly Data’ on the shortcut menu and chapter 2.3.5.3 includes details.

The current values for digital input can be changed with choosing ‘Change Value’.

Tag properties are changeable in case of choosing ‘Tag Properties’ Change button.

Clicking on ‘Set Temporary Value’ from the shortcut menu can make the current value fix as random values.
Hitting Page Up or Page Down displays previous and next tag for digital input on Digital Data View.
You can set the background color, font, font color and size, etc. of the digital trend screen from submenus of the Configuration Menu.

2.3.5.3 Digital Data View  XE " Digital Data View " 
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<Figure 2- 96> Example of Digital Data View
	Digital Data View displaying minutely, daily, weekly and monthly data using status values such as ON/OFF can be moved from View screen for Digital Inputs, Entire Tags, Registered Groups and digital input details, trend diagnosis, graphic element relating to digital, scripts, etc.
<Figure 2-97> comes up by clicking on the right mouse button on the screen.
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<Figure 2- 97> Shortcut Menu 
for Digital Data View


Users are able to change the order for Analog Data View (minutely → hourly → daily → weekly → monthly) by choosing [image: image168.png]Data[F4]



 from menu buttons.
Choosing [image: image169.png]Time[F12]



 can make Start Time for Data View change, and also the time is increased or decrease using [image: image170.png]Time-+[+]



 and [image: image171.png]


.
Digital Trend Diagnosis comes up by pressing one of ‘Digital Trend for 1 Hour ~ Digital Trend 30 Days’ and chapter 2.3.5.2 includes more details.

Digital data view time is modified by clicking one of ‘Digital Minutely Data ~ Digital Monthly Data’ from the shortcut buttons.
The current values for digital input can be changed with choosing ‘Change Value’.

Tag properties are changeable in case of choosing ‘Tag Properties’ button.
Clicking on ‘Set Temporary Value’ from the shortcut menu can make the current value fix as random values.

Hitting Page Up or Page Down displays previous and next tag for digital input on Digital Data View.
Background and text color, font and its size, etc. are set in Font or Color from Text Menu on the configuration menu.
2.3.6 Digital Outputs  XE " Digital Outputs " 
Choose View → Digital Outputs from the Text Menu, and then the digital output view such below <Figure 2-79> appears.
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<Figure 2- 98> Example of Digital Outputs
	A shortcuts comes up (see <Figure 2-99>) when you press the right mouse button on the selected list of digital input view. 

To move to Digital Output Detail View, choose [image: image173.png]DetailEnt]



, Digital Output Detail menu or double click on the left side of a mouse in the selected tag. For more information, refer to chapter 2.3.6.1.
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<Figure 2- 99> Shortcut Menu 

of Digital Output View



	Hitting [image: image175.png]Output[F3]



 button from the Menu or ‘Change Value’ in the shortcut menu can make values set for digital output tag in the dialog box <Figure 2-100> output.
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<Figure 2- 100> Dialog Box to Change Digital Output Values


The button [image: image177.png]Active[Fa]



 from menu is to install whether to use selected tag or not.
Pressing [image: image178.png]Tag[F11]



 or ‘Tag Properties’ makes it possible to change properties for digital output tags in the dialog box as following <Figure 2-101>.
[image: image179.png]Tag Modify (PDV1_R)

Conn | opcio0e (55

PLC_SCAN Relay Type,
Port @ latch  ONDelay

Station OFF Delay

Address Puise tine

Extral

Extraz

I~ Reverse

ONDes

OFF Des





<Figure 2- 101> Dialog Box to Change the Tag Property of the Dialog Output
Users can find tags they want, when inputting tag names or sequence numbers by hitting ‘Tag Search’ from the shortcuts and install color of background, text, tag, explanation and font, its size, etc. for Digital Output View in Font and Color from Configuration Menu.
2.3.6.1 Digital Output Details  XE " Digital Output Details " 
Digital Output Details displaying real- time trend diagnosis and set points for digital output current values as below <Figure 2-102> can be moved from Digital Outputs, Entire Tags, Registered Groups, scripts, etc.
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<Figure 2- 102> Example of Digital Output Details
	By hitting the right side button on a mouse, the shortcuts <Figure 2-103> appear.
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<Figure 2- 103> Shortcut Menu for 

the Detailed View Screen of Digital


The values set in output tags can be output by selecting [image: image182.png]Output[F3]



 button or ‘Digital Output Value Change’ from the shortcut menu.
Tag properties are changeable in case of choosing ‘Tag Properties’ Change button. 

Clicking Page Up or Page Down shows previous or next tag for digital input on the trend diagnosis screen. The background and text color, font and the size, etc. are set in Font or Color from Text menu in Configuration menu.

2.3.7 String Tags  XE " String Tags " 
Press ‘View | String Tags’ from the Text Menu, and then the string tags view as below <Figure 2-104> comes up.
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<Figure 2- 104> Example of String Tags View
	String Tag View is the screen possible to indicate all tag names, tag explanations, current values, setting status, etc. for output tag and to change tag contents.

Shortcuts such as <Figure 2-105> are displayed by clicking the right side mouse button on the selected list from the string tag view.
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<Figure 2- 105> Shortcuts for String Tag View

	Users are able to change current string values in dialog box <Figure 2-106> when double clicking one of [image: image185.png]Change[F3]



, ‘Change Value’ from the shortcuts or the left mouse button on the selected tag.
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<Figure 2- 106> Example of Dialog Box for String Change


The Maximum string length available to input in string tag is 255 English Characters.
The button [image: image187.png]Active[Fa]



 from menu is to install whether to use selected tag or not.

Properties for string tags can be changed in the dialog box <Figure 2-107> by hitting [image: image188.png]Tag[F11]



 or ‘Tag Properties’ from the shortcuts.
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<Figure 2- 107> Example of Dialog Box for String Tag Property Change
Users are able to find tags they want, when inputting tag names or sequence numbers by hitting ‘Tag Search’ from the shortcuts and install color of background, text, tag, explanation and font, its size, etc. for String Tag View in Font and Color from Configuration Menu.
2.3.8 View Registered Groups   XE " View Registered Groups " 
Clicking ‘View | Registered Groups’ from the Text Menu displays screen such as <Figure 2-108>.
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<Figure 2- 108> Example for Registered Groups View
Registered Group View is a screen to monitor and control analog, digital, string tags voluntarily registered by users.

	Clicking the right mouse button on the selected group from registered group view shows shortcuts such as <Figure 2-109>.
Detailed View is available by double clicking [image: image191.png]DetailEnt]



, ’Detail’ from the shortcuts or the left mouse button on the selected list and chapter 2.3.8.1 has more information.
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<Figure 2- 109> Shortcuts for Registered Group View



Selecting [image: image193.png]Insert{Ins]



, [image: image194.png]Add[+]



 or ‘Insert Group’, ‘Add Group’ from the shortcuts makes it possible to insert or add new groups in the dialog box <Figure 1-110>.
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<Figure 2- 110> Example of Dialog Box to Add Groups
Registered groups are changed by pressing [image: image196.png]Modify[F4]



 button or ‘Modify Group’ from the shortcuts.

	The dialog box <Figure 2-111> appears to confirm whether to delete registered groups by clicking [image: image197.png]Delete[Del]



 or ‘Delete Group’ from shortcuts.
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<Figure 2- 111> Dialog Box for Confirmation to Delete Groups



2.3.8.1 Detailed View of the Registered Group 
Detaild View of the Registerd Group displays tag names, descriptions, current values, properties, etc. for registered tags such as <Figure 2-112>. XE "Detailed View of the Registered Group" 
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<Figure 2- 112> Example of Registered Group Detailed View
	Pressing the right mouse button on the selected group from registered group detailed view displays shortcuts such as <Figure 2-113>.
Detailed monitor screens for each tag can be moved by clicking [image: image200.png]DetailEnt]



, Detail View, or double clicking the left mouse button, and dialog boxes to modify tag properties are open by pressing string tags.

See menu buttons and shortcuts explanations for analog input and output, digital input and output, string tags to have more information about various Menu for registered group view.

Color of background, tag, explanations, text and font type, size, etc. are set in Font or Color from Text Menu in the configuration menu.
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<Figure 2- 113> Shortcuts 
for Registered Group Detailed View


2.3.9 Alarm Files  XE " Alarm Files " 
Alarm Files View displaying names and the number of alarms by date such as <Figure 2-114> is shown by selecting ‘View | Alarm Files’ on Text Menu.

[image: image202.png]2007/11/22 Alarm Data
2007/11/26 Alarm Data
2007/12/14 Alarm Data
2007/12/24 Alarm Data
2007/12/27 Alarm Data
2007/12/28 Alarm Data
2008/01/01 Alarm Data
2008/01/03 Alarm Data
2008/01/04 Alarm Data
2008/01/07 Alarm Data
2008/01/08 Alarm Data
2008/01/03 Alarm Data
2008/01/10 Alarm Data

DetailEnt]

20071122.A.3
20071126.43

20071214.6.3

20071224, ALMX,
20071227, ALMX.
20071228, ALMX.
20080101, ALMX,
20080103 ALMX.
20080104, ALMX.
200801 07. ALMX.
200801 08, ALMX.
20080109, ALMX.
20080110, ALMX





<Figure 2- 114> Example of Alarm Files View
	Press the right mouse side button on the selected list from Alarm View, the shortcut menu <Figure 2-115> appears.
Clicking [image: image203.png]DetailEnt]



, or ‘View Alarm List’ menuitem from the shortcuts or double clicking the left mouse button on the selected list can move screens to view alarm content and chapter 2.3.9.1 has more details.

	[image: image204.png]View Alarm List
Delete Alarm File

Close




<Figure 2- 115> Shortcuts for Alarm View

	Choosing [image: image205.png]Delete[Del]



 or Delete Alarm File displays the dialog box <Figure 2-116> to confirm whether to delete alarm files.
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<Figure 2- 116> Dialog Box to Confirm 
Whether to Delete Alarm Files


2.3.9.1 Alarm List View  XE " Alarm List View " 
‘Alarm List’ screen available to move to Alarm View or Script shows generated alarms on chosen date by categorized level, date, time, tags, explanations, alarm contents etc. such below <Figure 2-117>.
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<Figure 2- 117> Example of Alarm Content View
	Use the right mouse button to bring up shortcuts <Figure 2-118> on Alarm Content View.
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<Figure 2- 118> Shortcuts 
for Alarm Content View

	When the [image: image209.png]Priority



 Alarm Priority button or Select from the short cut menu is pressed, the dialog box <Figure 2-119> appears.
Choosing an alarm priority you want in the dialog box <Figure 2-119>, the alarm content set is displayed.
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<Figure 2- 119> Example of Dialog Box 
to Select Alarm Priorities


[image: image211.png]


 button or ‘Print’ provides a dialog box <Figure 2-120> available to print out the current alarm content view screen in the set printer by clicking [image: image212.png]


 after installing printer types to use, number of copies, etc.
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<Figure 2- 120> Example of Dialog Box for Printing Alarm Content
Specifying months, days and years using ‘ViewAlarmList’ script functions displays alarm contents for over 2 days.
2.3.10 Alarm Events  XE " Alarm Events " 
Alarm View by date such as <Figure 2-121> is shown by selecting ‘View | Alarm Events’ from the Text menu.
Alarm types displayed in alarm event window are set by selecting ‘During alarm’ or ‘Until users confirm’ buttons in screen alarm types from ‘Config | Alarm Priority’ menu in Studio.
When alarms depending on priority are generated by installing ‘Config | Config Alarm’, the alarm event window can be automatically displayed on monitor screen.
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<Figure 2- 121> Example for Alarm Event Window
Generally, an alarm event window possible to be input in elements on graphic monitor screen is created in toolbar window to confirm raised alarms.
	Shortcut Menus such as <Figure 2-122> are indicated by pressing the right side mouse button on the selected list from alarm event window.
Alarm confirmation is available using one of ‘Confirm One Alarm’, ‘Confirm One Page’, ‘Confirm All Alarms’ from the shortcut menu <Figure 2-122> or scripts.
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<Figure 2- 122> Shortcut Menus for Alarm Event Window


Clicking one of ‘Delete Alarm’, ‘Delete All Alarms’ buttons or script makes it possible to delete raised alarms.

It is available to sound or stop alarms by selecting either ‘Disable Alarms’ or ‘Alarm Sound’ from shortcut menu in event window.
Choosing ‘Sound Alarms’ from shortcut menus in event window or setting in ‘Config | Config Alarm’ menus is to decide whether to sound alarms or not.

2.3.11 Log Files  XE " Log Files" 
Click on ‘View | Log Files’ from Text Menu to display Log View screen by date such as <Figure 2-123> showing generated log dates and file names.
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<Figure 2- 123> Example of Log Files View Screen
	The right mouse button on the selected list opens shortcut menu such as <Figure 2-124>.
Log Content screen can be moved by pressing [image: image217.png]DetailEnt]



 or ‘View Log List’ or double clicking the left mouse button on the log list and chapter 2.3.11.1 includes more information.

Clicking [image: image218.png]Delete[Del]



 or ‘Delete Log File’ from buttons provides the dialog box <Figure 2-125> to confirm again whether to delete log files.
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<Figure 2- 124> Shortcut Menu for Log View
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<Figure 2- 125> Dialog Box to Confirm Whether
To Delete Log Files


2.3.11.1 Log List View  XE " Log List View " 
Log List View <Figure 2-126> available to move to Log View screen and scripts shows start, close information for programs and communication information, etc.
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<Figure 2- 126> Example to View Log List
	Use the right mouse button to bring up shortcut menus <Figure 2-127> on Log List View.
The set printer can print the current log content view screen by choosing [image: image222.png]


 button or ‘Print Logs’ from the shortcut menus.
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<Figure 2- 127> Shortcut Menus for Log List View

	
	


2.3.12 Scripts  XE " Scripts " 
Selecting ‘View | Scripts’ from Text Menu displays script continuously while the monitor program such as <Figure 2-128> written in Studio runs.
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<Figure 2- 128> Example for Scripts View
	Shortcut Menus such as <Figure 2-129> are shown by using the right side mouse button on the selected list from script view screen.

Use [image: image225.png]RunfStop[F3]



 from script menu buttons to run or stop scripts.
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<Figure 2- 129> Shortcut Menus for Scripts View


A dialog box such below <Figure 2-130> appears, when the left mouse button is double clicked on [image: image227.png]DetailEnt]



 button, ‘Script Details’ from the shortcut menu or the selected lists.
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<Figure 2- 130> Example of Dialog Box for Script Details View
The above screen of <Figure 2-130> shows script content and the below one displays the types, names, the current values for set values types.
2.3.13 Communication Server  XE " Communication Server " 
Selecting ‘View | Communication Server’ from Text Menu shows communication server running files after activation and chapter 3 includes manuals to use communication programs.

2.3.14 Reports  XE " Reports " 
This menu is to confirm and print out report results written in Studio.
	Pressing ‘View | Reports’ from Text Menu opens a dialog box <Figure 2-131>.
Report View <Figure 2-132> is shown by selecting report files using the dialog box <Figure 2-131>, scripts, etc.
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<Figure 2- 131> Example of the Dialog Box to Open Report Files
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<Figure 2- 132> Example for Report View 
Clicking [image: image231.png]


 makes the current report contents print out.
Select [image: image232.png]


 to display Preview about the contents to print out.

Pressing either [image: image233.png]


 or [image: image234.png]


 makes it possible to zoom in and out of report contents by 10 % ~ 200 %.

Use [image: image235.png]


 to set standard time for Report View in <Figure 2-133>.
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<Figure 2- 133> Dialog Box to Set Standard Time for Report View
Modifying the standard time for Report View is available using [image: image237.png]200 =y

[z =m

1z =



 and renewing report contents is possible by choosing [image: image238.png]


.
The standard time for Report View is changeable into the current time using [image: image239.png]Set to current date



.
Reports made in Studio can be automatically printed out at regular intervals set ‘Config | Automatic Report Print’ Menu and Chapter 2.4 has more details. 
2.3.15 Demand Controls  XE " Demand Controls " 
Demand Graph, one of elements to display graph concerning demand controls status for power control, is used to analyze power flow and an amount of power for 15 minutes.
Choosing ‘View | Demand Controls’ from the Text Menu indicates demand controls items registered such as <Figure 2-134> and demand window for selected items.
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<Figure 2- 134> Example for Demand Controls Screen
Comments for Demand Window of graphic elements is also applied to the Display Principles because Demand Windows on Demand Controls and for graphic elements are identical.
Studio is responsible for setting demand items displayed on demand controls window, demand height tags for each item, tags for reading time flow, the current values, installing standards, the total time for graph, font, background color, etc.
2.3.16 Milli-Datas View  XE " Milli-Datas View " 
Milli-Datas View displays graph such as <Figure 2-135> concerning data that installed analog or digital tags are saved in MDB File at 1 ~ 60,000 mSec intervals.
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<Figure 2- 135> Example for Milli-Datas View
The upper window of Milli-Datas Data View shows all data collected and the lower one displays data values for selected area in the upper one.

The area to display on the lower screen is chosen by moving a mouse with still pressing the left mouse button on the upper one.

Pressing the left mouse button on tag name display modifies the selected tag into the standard tag and clicking the right one sets whether to show graph on the lower window.
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 button from Menu on Milli-Data View is to import data to show in the dialog box <Figure 2-136>.
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<Figure 2- 136> Example for Milli-Data View
	[image: image244.png]Config[F3]



 button enables you to set time display for Milli-Data View as well as background color in the dialog box <Figure 2-137>.
Users are able to set data collection tags, intervals, conditions, Fonts, display color, etc. in Studio.
Additionally, writing scripts such as MilliDataSetFile, MilliDataSetTimeType, etc. in Studio makes it possible to install display data selection and time base display methods for milli-data window.
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<Figure 2- 137> Example of Dialog Box 
for Milli-Data View Settings


2.3.17 Schedules  XE " Schedules " 
Schedule allows users to register running lists in advance to work at the set time each year, month, week, day to automatically control operations mainly used for Lighting Control. Choose ‘View | Schedules’ from Text Menu to display a monthly schedule <Figure 2-138> below.
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<Figure 2- 138> Example of Schedule Screen
Adding or subtracting months on annual schedule screen is available from [image: image247.png]


 in the <Figure 2-138> and schedule control lists for each date can be checked by pressing left mouse button on a day (1~31) for selected months.
The lower right screen for schedule displays today control lists, control contents for each list, whether to control instruments or not.
Generally, schedule is set according to the following order.
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Choosing [image: image249.png]Fived Schedule[F3]



 or ‘Config | Schedule | Yearly Fixed Schedule’ displays the dialog box <Figure 2-139> to set annual fixed schedules.
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<Figure 2- 139> Example of Dialog Box for Yearly Fixed Schedules
Users are able to set additional annual schedules in the dialog box <Figure 2-140> by selecting [image: image251.png]Additional Schedule[F4]



 or ‘Configuration | Schedule | Yearly Additional Schedule’.
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<Figure 2- 140> Example of Dialog Box for Yearly Additional Schedule
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<Figure 2- 141> Example of Dialog Box for Daily Operating Model
Pressing [image: image254.png]Model[Fé]



 or ‘Config | Schedule | Model’ menu item opens the dialog box <Figure 2-141> possible to set daily operating models.
Users are able to register the maximum number of 32767 different tags in a daily operating model to set daily running time, time stopped working, etc. at specific running points.
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 or ‘Config | Schedule | Weekly Schedule’ button can be used to display the dialog box <Figure 2-142> available to set weekly schedules.
Weekly schedules are to register fixed schedule set on each day (Sunday ~ Saturday, Holiday, Special Day).
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<Figure 2- 142> Example of Dialog Box
for Weekly Schedule Settings


2.3.18 DB Integrations  XE " DB Integrations " 
DB Integrations shows integrated values of data saved as database data for previous and this year, previous and this month, previous and this day, previous and this time in run program.
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<Figure 2- 143> Example of Dialog Box for DB Integration
Pressing ‘View | DB Integrations’ from the Text menu will open the dialog box for DB Integration Data View such as <Figure 2-143>.
DB Integration means PI Integration as well.

Data to display DB Integration can be added or deleted in the dialog box <Figure 2-144> by clicking ‘File | List Settings’ in <Figure 2-143>.
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<Figure 2- 144> Example of Dialog Box for DB Integration List Settings
<Figure 2-145> appears by choosing [image: image259.png]Add



 button from <Figure 2-144>.
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<Figure 2- 145> Dialog Box to add DB Integration Lists
DB Integration Lists are added by selecting saved lists and integration tags in <Figure 2-145> for database registration in run programs.
Saved lists and integration tags are required to add DB Integration Lists.
The [image: image261.png]Delete



 button in <Figure 2-144> can be used to erase selected DB Integration Lists.
2.3.19 Navigation  XE " Navigation " 
Navigation is a screen to display entire graphic monitor such as <Figure 2-146> for the current activated MDI property.
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<Figure 2- 146> Example of Navigation Screen
Holding the left mouse button and moving it left or right will show rectangles available to enlarge or reduce the current screen depending on the image size of the selected rectangle.
2.4 Descriptions by Each Menu  XE " Menu " 
The Menu bar consists of File, View, Config and Help on monitor programs.

The menu order can be changed by either choosing scripts or modifying ‘menu.mnux’. (Refer to the edit program manual.)

2.4.1 File Menu  XE " File Menu " 
	File Manu has Login, Logout, Write Memo, Read Memo, Print Screen, Save Screen, Save Selection Zone, Run Studio such as <Figure 2-147>.
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<Figure 2- 147> File Menu


2.4.1.1 Log In  XE " Log In " 
Log In is to leave use records and for system security when several users use in a system.
Choosing login from File Manu opens user login dialog box <Figure 2-148> available to input the username and password made by the manager for login.

Managers are able to give users their usernames, password, permission, etc. and the manager username and the initial password are ADMIN.
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<Figure 2- 148> Example of Log In Dialog Box
The username and password should be less than 39 characters with English letters and numbers.
Managers are able to register, change users, give authorization and modify passwords for each user from ‘Config | Config Users’ menu.
2.4.1.2 Log Out  XE " Log Out " 
This is to set only ‘monitor program view’ without logged in users.
The username logged out is _PUBLIC_ using Logout from File Menu.
2.4.1.3 Write Memo  XE " Write Memo " 
The dialog box such as <Figure 2-149> appears by clicking ‘Write Memo’ menu to write emails to other users.
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<Figure 2- 149> Example for Writing Memo
After writing memo titles and contents, press ‘Send’ with choosing users to receive it.  If you want to send emails several users at a time, select usernames in ‘Send To’.
2.4.1.4 Read Memo  XE " Read Memo " 
<Figure 2-150> opens up by selecting the ‘Read Memo’ menu available to read emails received from other users or getting email from logged in users when you log in.
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<Figure 2- 150> Dialog Box to Read Memo
After selecting an email list in <Figure 2-150>, press [image: image267.png]


 or double click the left mouse button to read emails.

Use [image: image268.png]Delete



button to erase the selected memo.
2.4.1.5 Print Screen XE " Print Screen " 
Print Screen are to print the current window screens as bitmap graphics formats, and the dialog box <Figure 2-151> comes up by pressing ‘Print Screen’.
[image: image269.png]Print Screen

Printer AP LaserJet 1200

P

Close.

Property.

T~ Reverse





<Figure 2- 151> Dialog Box to Print Screen
Screen Printing is completed successfully by clicking [image: image270.png]


 buttons, after adjusting the image area on the left side of <Figure 2-151> to print out and setting types of printers.
You can set paper size, orientation, margins, the printer, etc. using [image: image271.png]Property.



 in ‘Print Screen’ dialog box.
It is available to print images in reverse order by clicking on [image: image272.png]I~ Reverse



 and also save and load setting contents to print screens with [image: image273.png]


 and [image: image274.png]


 buttons.
2.4.1.6 Save Screen  XE " Save Screen " 
The current windows screen can be printed with bitmap graphics formats using BMP and JMP available to be saved.

2.4.1.7 Save Selected Screen  XE " Save Selected Screen " 
This feature is to save the only selected region on the current windows screen as bitmap graphics formats.

To open the dialog box such below <Figure 2-152>, press Save Selected Screen form File Menu.
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<Figure 2- 152> Dialog Box to Save Selected Screen
If you click to check [image: image276.png]I~ Reverse



 or [image: image277.png]I~ Full



 in <Figure 2-152>, you can modify images in reverse order or choose the entire screen. It is available to save and load setting contents for saving on the selected screen by pressing [image: image278.png]


 or [image: image279.png]


 button.

Selected images can be saved as Bitmap (BMP, JPG) using [image: image280.png]


button after choosing image areas to save in <Figure 2-152>.

2.4.1.8 Run Studio  XE " Run Studio " 
Only authorized users are able to run Studio after closing down the monitor program.

Choosing ‘Run Studio’ on graphics monitor screen is to run Studio available to modify current graphics screens, and on tag monitor screen possible to move to Studio keeping edited tags. And Studio is run with edited scripts in script monitor.
2.4.1.9 Exit  XE " Exit " 
The dialog box <Figure 2-153> is to ask whether you close the monitor program or not.

Outsiders who do not have permission ‘Close’, or unauthorized are not able to close monitor program.  XE " The Shutdown Privilege " 
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<Figure 2- 153> Dialog Box to Ask Whether to close Monitor Program
2.4.2 View  XE " View " 
View Menu contains commands such as Graphics, Entire Tags, Analog Input, Analog Output, Digital Input, Digital Output, String Tags, Registered Groups, Alarm Files, Alarm Events, Log Files, Scripts, Communication Server, Reports, Demand Controls, Milli-Datas, Schedules, DB Integrations, Navigation.  For more information, refer to chapter 2.3.
2.4.3 Config  XE " Config " 
	Necessary data, Font size, screen status, etc. to run monitor program are set in Config text menu including sub menus such as Config Alarm, Config Font, Config Colors, Config Data, Config Flow Watch, Config Users, Config Other, Config Excel Path, Database, Schedule, Automatic Report Print.
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<Figure 2- 154> Config Menu


2.4.3.1 Config Alarm  XE " Config Alarm " 
The following dialog box <Figure 2-155> appears when you click ‘Config | Config Alarm’ Text Menu.
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<Figure 2- 155> Dialog Box to Set Configuration for All Alarm
Users are able to set whether to Disable all alarms, alarm sound, alarm smessage, Alarm Filters, Alarm when manual operation failed, Digital tag output when alarms occur, etc.
2.4.3.2 Config Font  XE " Config Font " 
Clicking Config Font from Config Text Menu opens up the dialog box <Figure 2-156> to set Fonts available to change fonts and font size on Windows screens.
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<Figure 2- 156> Dialog Box to Select Font
2.4.3.3 Config Colors  XE " Color "  XE " Config Colors " 
Config Colors buttons on Config Menu bring up a submenu to set all colors and alarm colors.

	1) Basic Colors
Pressing Basic Colors button is available to open up the Dialog Box <Figure 2-157> to set Text, Background, Tag, Description, Inactive, HiHi, High, Low, LoLo, ON, OFF Color, etc.
 XE " Basic Color " 
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<Figure 2- 157> Dialog Box to Set Basic Colors

	2) Alarm Colors
By clicking Alarm Colors, <Figure 2-158> comes up to set colors for HiHi, High, Low, LoLo, DI ON, DI OFF, Return, Manual Operation, Demand Control, etc.
 XE " Alarm Color " 
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<Figure 2- 158> Dialog Box to Set Color


2.4.3.4 Config Data  XE " Config Data " 
To bring up the dialog box <Figure 2-159> below, choose Config Data button from Config Text Menu.
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<Figure 2- 159>> Dialog Box to Set Data Management
Users can set whether to save all data, Data directory, days to keep data, intervals to save minute data, start saving data, duplex server data, etc. in dialog box <Figure 2-159>.

Assigned directories are to save data for time, minutes, log, alarms, etc. and start time for storing data aims to save data after setting time to get correct data with running monitor program. If Intervals to Save Minute Data are set with 10 minutes, users are able to save time for storing data.
2.4.3.5 Config Users XE " Config Users " 
Choosing Config Users from Config Text Menu brings up <Figure 2-160> below available to register new usernames, delete users and set user permissions and password, etc.
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<Figure 2- 160> Dialog Box for User Settings
The following <Figure 2-161> to set usernames, web settings, control tag registration, etc. comes up by selecting [image: image289.png]Add.



 or [image: image290.png]Modify



 button in the dialog box for user settings.
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<Figure 2- 161> Dialog Box for Setting User Properties
Deleting registered users and changing user passwords are available by clicking [image: image292.png]Delete



 or [image: image293.png]


 button.

Permission to delete users is given to only the manager and password changing is available by the manager and the user oneself.

To set the default logon user and the manager password, select administrator item tab in the dialog box for user settings.

2.4.3.6 Config Other  XE " Config Other " 
When you choose Config Other Settings from Config Menu, the following dialog box <Figure 2-162> appears. And it is to set ‘Display tool tip on tag object’, ‘Align to window edge’, ‘Respond to left mouse click on graphics module’, ‘Respond to right mouse click on graphics module’, ‘Use menu buttons on graphics module’, ‘Max MDI Window Control’, ‘Match to display format in AI calculation’, ‘Pause Scan’, ‘Scan Start Time’, ‘Close Communication Server when closing this program’, ‘Display Prompt box when closing this program’, etc.
‘Scan Start Time’ indicating starting time to regularly operate monitor and communication programs, is generally set for 5~30 seconds input for each second.
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<Figure 2- 162> Dialog Box for Other Config
2.4.3.7 Config Excel Path  XE " Config Excel Path " 
Clicking ‘Config Excel Path’ necessary for script functions related to Excel Report from Config Text Menu brings up <Figure 2-163> available to set the route including Excel Program Executable File, Microsoft.
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<Figure 2- 163> Dialog Box for Excel Path Settings
2.4.3.8 Database  XE " Database " 
Sub Menu for connection string and shared database appears by selecting Database button from Config Menu.
1) Connection String  XE " Connection String" 
Connection String is to set database types and names to connect with database in functions related to database for script and run programs.
<Figure 2-164> is available to set connection strings depending on database types.

[image: image296.png]Database Connection String

Connection tring





<Figure 2- 164> Dialog Box for Connection String Settings
[image: image297.png]Add.



 or [image: image298.png]Modiy.



 button in <Figure 2-164> brings up <Figure 2-165> possible to add or modify connection strings by inputting the titles, database types and connection strings for each database.

Refer to database program manuals and Help to set connection strings input different according to database types such as an example of <Figure 2-165>.
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<Figure 2- 165> Example of Dialog Box to Add or Modify Connection Strings
2) Shared Database  XE " Shared Database " 
This feature is to share current values and tags for monitor programs with external systems by storing tag names and current values in table ‘TAG’ and ‘CURR’ column.
Users are able to set connect strings depending on database types in <Figure 2-166> by pressing shared database.
When you check Able in dialog box <Figure 2-166>, raised alarms are to be read from external programs by saving them in the database table.

[image: image300.png]Config Shared Database

I~ Active shared Database.

™ Save relation Duplex Server

DS

Table

TagExchange  [TagEvchange

Hlarm File [larmFie





<Figure 2- 166> Dialog Box for Shared Database Settings
2.4.3.9 Schedules  XE " Schedules " 
Clicking Schedules menu from Config Text Menu displays sub menu such as settings for Yearly Fixed Schedules, Additional Annual Schedules, Models, Weekly Schedules.
Each menu for schedule control is equal to menu button setting for ‘View | Schedules’ and therefore you can refer to annual schedule comments to use.
2.4.3.10 Automatic Report Print  XE " Automatic Report Print " 
This feature is to print automatically set reports hourly, daily, monthly and the following <Figure 2-167> shows the settings item to print report automatically currently set.
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<Figure 2- 167> Dialog Box to Automatic Report Print
Selecting [image: image302.png]Add.



or [image: image303.png]Modiy.



 button in <Figure 2-167> opens up the dialog box <Figure 2-168> to add or modify the feature to print report automatically.
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<Figure 2- 168> Dialog Box Example to Add or Modify Function to Automatic Print Report
Adding or modifying function to print report automatically is available by inputting report file names, printer names and automatic print cycle in <Figure 2-168>.
Two types of report files are available to be set for automatic report print.  One is the default report written in Studio and the other is written with the excel report function.
2.4.4 Windows
	When you click on Window menu from monitor program, the menu pulls down, revealing a list of menu item <Figure 2-169> such as Cascade, Tile Horizontally, Tile Vertically, Arrange Icons, Close, Close All.
Refer to Window Manuals because the instructions between each sub menu from Window Menu and original Window menus are same.
 XE " Windows Menu" 
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<Figure 2- 169> Windows Menu


2.4.5 Help  XE " Help " 
	Pressing Help Menu brings up the dialog box <Figure 2-170> showing Help, Remote AS, UserName?, Keylock Information, About?.
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<Figure 2- 170> Help Menu


2.4.5.1 Help
‘Help’ can be chosen in each dialog box by clicking on ‘Help’ button.
	2.4.5.2 UserName?  XE " UserName " 
The dialog box <Figure 2-171> by choosing Username? Displays currently logged in username.
	[image: image307.png]Current username is [ADMIN]

&





<Figure 2- 171> Example of the Dialog Box to View Username


2.4.5.3 Keylock Information  XE " Keylock Information " 
The dialog box <Figure 2-172> displays the keylock Information by selecting Keylock Information Menu.
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<Figure 2- 172> Dialog Box for Keylock Information
2.4.5.4 About?
By selecting ‘About’ Menu, <Figure 2-173> comes up revealing program names, versions, development company, etc.
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<Figure 2- 173> Dialog Box for Program Information
<Empty Page>

Chapter 3. Communication Server 
Communication Server specify how to communicate with Controller or PLC and memory address and size read from them.  XE "PLC_SCAN.EXE" 
Communication Servers move the data acquired by communicating with PLC or Controllers in the diagram <Figure 3-1> below into memories for them and send it to monitor programs when requested.  XE " Communication Server " 
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<Figure 3- 1> Communication Server Diagram
3.1 Communication Server Running
Select ‘Communication Server’ ([image: image311.png]


) from AutoBase Windows or Start Program to run communication server.
Communication Server is run automatically when monitor programs are operated with communication mode.

3.2 Whole Figure and Shortcuts Descriptions
3.2.1 Whole Figure Descriptions
When you run communication server, the screen <Figure 3-2> appears.
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<Figure 3- 2> Initial Screen for Communication Server 
3.2.1.1 Title Bar
This is an original window feature to display names such as <Figure 3-3> on upper screen.
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<Figure 3- 3> Title Bar
3.2.1.2 Menu Bar  XE " Menu Bar " 
The Menu Bar includes File, View, Config, Window and Help from Communication Server.

Users are able to select menus they want by moving the mouse and clicking the left mouse button on Text menu items, or pressing ‘Enter’ on menu items with pressing ‘ALT’ or ‘F10’ on keyboard.

3.2.1.3 Menu Button  XE " Menu Button " 
Menu buttons are displayed below the horizontal scroll bar from Communication Server.

3.2.1.4 Windows Internal Area
Windows Internal Area displaying contents for communication server is changed depending on screen types.

3.2.2 Shortcuts Descriptions  XE " Shortcuts " 
Keyboard Shortcut Summary in communication server is shown below in <Table 3-1>.
	SHORTCUTS
	FUNCTIONS

	ENTER 
	Select functions and check menus, etc.

	ESC 
	Cancel functions and move back to previous the menu.

	SYMBOL 225 \f "Wingdings",SYMBOL 226 \f "Wingdings",SYMBOL 223 \f "Wingdings",SYMBOL 224 \f "Wingdings" (arrow keys) 
	Move between menus.

	ALT, F10 
	Move to the Menu Bar.

	SHIFT+F5 
	Cascade MDI Windows

	CTRL+F4 
	Close the MDI Window currently selected.

	PGUP, PGDN, Other FUNCTION Keys
	Use differently for each monitor screen.

	Other Default Shortcut Keys
	Default Shortcut Keys for Windows


<Table 3- 1> Shortcut Descriptions for Communication Server
3.3 Descriptions for each Menu  XE " Menu " 
The Text Menu consists of File, View, Config, Window, Help on communication server.
3.3.1 File Menu  XE " File Menu " 
	File Menu includes sub items such as ‘Edit Port File’, ‘Bit Write’, ‘Word Write’, ‘Virtually Write’, ‘Close’ in <Figure 3-4>.
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<Figure 3- 4> File Menu Item for 
Communication Server


3.3.1.1 Modify Communication Ports  XE " Modify Communication Ports " 
The dialog box <Figure 3-5> to choose communication ports comes up by selecting ‘Edit Port File’ button from File Menu.
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<Figure 3- 5> Dialog Box to Choose Communication Port.
Clicking on communication ports in <Figure 3-5> to set opens up <Figure 3-6> to edit communication files.
Users are able to refer to chapter 3.4 and 3.5 to edit it.
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<Figure 3- 6> Dialog Box to Edit Communication File
3.3.1.2 Bit Write  XE " Bit Write " 
‘Bit Write’ buttons function to test Bit Control for controller and PLC linked to the specified communication port without connecting to the monitor program.
	Clicking on ‘Bit Write’ brings up <Figure 3-7> to test it by setting communication ports to output, stations, address, extra 1, extra 2, etc.
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<Figure 3- 7> Dialog Box to Write Bit


3.3.1.3 Word Write  XE " Word Write " 
‘Word Write’ button is to test word, double word and float values for controllers or PLC connected to specified communication ports without linking to the monitor program.
	Users are able to set communication ports to output, stations, address, extra 1, extra 2, etc. to test write word in <Figure 3-8>.
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<Figure 3- 8> Dialog Box to write word


3.3.1.4 Virtual Write  XE " Virtual Write " 
‘Virtual Write’ button has a function to change only communication memory values for WORK, FLOAT, DWORD without outputting on PLC or Controller.
<Figure 3-9> comes up by selecting ‘Virtual Write’ button to set ports, address, memory types and writing values for communication memory for Virtual Write.
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<Figure 3- 9> Dialog Box for Virtual Writing
3.3.1.5 Exit  XE " Exit "  XE "Exit Communication Program" 
Press ‘Exit’ button to close the communication server.
You should not close the communication server available to communicate with PLC to monitor regularly.

3.3.2 View Menu Items  XE " View Menu Items " 
View Menu Items consist of sub menus to display Main Program, Memory, Communication Code (Hex), Communication Code (ASCII), Port Status, Network Memory Server, DLL Protocol Information.
3.3.2.1 Main Program  XE " Main Program " 
Selecting ‘Main Program’ button activates or runs the monitor program.
3.3.2.2 Memory  XE " Memory " 
Real communication memory read from PLC or Controllers can be displayed by choosing ‘Memory’ such as <Figure 3-10> according to the order of WORD/FLOAT/DWORD /STRING/SYSTEM.
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<Figure 3- 10> View Memory Structure
Pressing [image: image321.png]'WORD/FLOAT/DWORD/STRING



 button shows communication memory types depending on the changed order of WORD, FLOAT, DWORD, STRING, SYSTEM and clicking on [image: image322.png]Prev Port



 or [image: image323.png]Next Port



 displays them with modified communication ports.
Comm Try, Code Bad and Time Out for current communication ports are displayed on the bottom of the screen to show communication status for each communication ports.

The data such numbers of communications, etc. is for a day and communication results are saved in log.

3.3.2.3 Communication Code into Hex 

Code in current communications is changed into HEX using ‘Communication Code (Hex)’ button on screen in <Figure 3-11>. XE " Communication Code into Hex " 
Communication Code View is displayed in Hex or ASCII format by choosing [image: image324.png]Hex/Ast



 from View Menu.
After pausing View, pressing again [image: image325.png]


 makes it possible to view communication code, however communication continues during the pause.
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<Figure 3- 11> Example to View Communication Code in Hex
Users are able to choose communication code view for different ports by clicking on the area displayed with numbers such as 000, 001 on the left side of screen and currently set communication port number in <Figure 3-11>.

3.3.2.4 Communication Code into ASCII 
This button including a similar feature with Communication Code (ASCII) shows communication code into ASCII format.  XE " Communication Code into ASCII " 
3.3.2.5 Port Status  XE " Port Status " 
When you click on ‘Port Status’ from View Menu, <Figure 3-12> comes up to display names, telephone number, Device settings, total counts of communications ,bad code and timeouts, etc. for ports from No. 0 to No. 255.
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<Figure 3- 12> Screen to View Port Status
3.3.2.6 Network Memory Server  XE " Network Memory Server " 
<Figure 3-13> displaying setting status screen for network server appears by pressing ‘Network Memory Server’ button.
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<Figure 3- 13> Screen for Network Memory Server Status
Network memory server directly sends communication memory contents to other computers via ports for connection number 0 to 255.
Double clicking the left mouse button on the connection numbers in <Figure 3-13> brings up the dialog box <Figure 3-14> to set Connection Type, Serial Port Settings, Items counts for one time,  Send Delay, etc. for network memory serer.
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<Figure 3- 14> Dialog Box to set connection for network memory server
The chapter 4 will help you understand concepts of communication and types of settings for network memory server and client. 

3.3.2.7 DLL Protocol Information  XE " DLL Protocol Information " 
Clicking on DLL Protocol Information button from View Menu items shows the filename, protocol, date, file size, version, etc. for communication protocol currently registered as following as in the following <Figure 3-15>.
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 to upgrade all DLL Protocol in Protocol folder which is a subfolder for running file folder.

Copy developed DLL file in the Protocol folder in case a new protocol file might be developed and choose [image: image334.png]Update st



 button to register one.
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<Figure 3- 15> Dialog Box for DLL Protocol Information
3.3.3 Config Menu Item  XE " Config Menu Item " 
	Config Menu Items consists of submenus such as Options, Editor Font and Modem Options as follows <Figure 3-16>.
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<Figure 3- 16> Configuration Menu


3.3.3.1 Options  XE " Options " 
If you click on ‘Options’ button, the <Figure 3-17> appears available to set Message Screen, Communication Delay Time, etc.  XE "VipScan" 

 XE "SetVipScan" 
‘MultiPort MultiTasking’ in <Figure 3-17> is to set whether to try Port Read for another port after reading one in several ports. XE"MultiPort MultiTasking"
Using MultiTasking in several serial communications makes all communication speed faster.
Additionally, scan count in Manual/SetVipScan is set to manually output or read VipScan Points specified with scripts of the monitor program faster than other points.
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<Figure 3- 17> Dialog Box to Set Total Configuration
3.3.3.2 Editor Font  XE " Editor Font " 
Fonts available in protocol settings can be set using Editor Font button from Config Menu Items.
3.3.3.3 Modem Options  XE " Modem Options " 
You are able to set initial commands for modem ports to dial up connection by choosing ‘Modem Options’ Menu.

3.3.4 Windows Menu Items  XE " Windows Menu " 
Window Menu Items similar to the original functions for MDI Windows includes submenus to Cascade, Tile Horizontally, Tile Vertically, Arrange Icons, Close All and select open windows as follows. (See <Figure 3-38>)
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<Figure 3- 18> Windows Menu Items
3.3.5 Help Menu Items  XE " Help Menu " 
The Help Menu Items contain submenus such as Help, Using Help and System Information in <Figure 3-39>.
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<Figure 3- 19> Help Menu Items
3.3.5.1 Help
If you click on either Help, F1 buttons from Help Menu Items or the Help button in dialog boxes, Help for the communication server appears.

3.3.5.2 Using Help
Users are able to see the basic help usage provided in Windows by selecting the ‘Using Help’ button.

3.3.5.3 System Information
By pressing the System Information button, the <Figure 3-20> comes up displaying writing values and numbers of writing items waiting in the dialog box below.
The writing items waiting are waiting in the communication server not output in points controlled with manual control, scripts, etc. from the monitor program.
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<Figure 3- 20> Dialog Box for System Information
3.4 Communication Setting Method
The Communication Setting Method is to set communication devices, protocol, types of reading, etc. between field equipment and communication server.
 XE " Communication Setting Method "  
3.4.1 Device  XE " Device " 
Generally used communication device contains Serial(RS-232C, RS-485, RS-422), Network (TCP/IP, UDP/IP), input/output card with built-in computer, Field Bus, Profi Bus, OPC or other communication formats.

3.4.1.1 Serial  XE " Serial " 
Serial devices used in usual COM port communication include RS-232C, RS-485, RS-422, etc. 

RS-485 or RS-422 communication is recommended in long distance communication (over 15 m) instead of the type of RS-232C not dependable for accuracy.

Using Exclusive cards for communication or RS-232 ~ RS-485/RS-422 communication converters is required for RS-485 and RS-422 communication.
The following <Figure 3-21> ~ <Figure 3-23> are 9 pin and 25 pin standard communication cable connection diagram for RS-232C communication.
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<Figure 3- 21> RS-232C 9pin~25pin communication cable connection diagram
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<Figure 3- 22> RS-232C 9pin~9pin communication cable connection diagram
For more information about cable connection methods, refer to manuals for equipment in case that serial communication cables such as RS-232C would need different types of connection depending on kinds of machines.

The communication server and Baud Rate, Parity Bit, Data Bit, Stop Bit, etc. in serial communications must match for regular communications.
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<Figure 3- 23> RS-232C 25pin~25pin communication cable connection diagram
3.4.1.2 Network  XE "TCP/IP" 

 XE "UDP/IP"  XE " Network " 
LAN or network card in computers should be set for network devices.

Generally, the communication protocol for network devices uses TCP/IP and UDP/IP.

Refer to the network machine manual about LAN for network devices or communication cable wiring.

TCP/IP and UDP/IP protocols are required to set IP addresses and service ports for machines to communicate.
3.4.1.3 Internal Computer Card  XE " Internal Computer Card " 
Internal cards are input and out cards for digital or analog (A/D or D/A card) set in computer slot.

Set machines for the internal card with referring to setting programs or manuals provided by each manufacturer.

3.4.1.4 FieldBus, ProfiBus  XE "FieldBus" 

 XE "ProfiBus" 
Communications by fieldbus, profibuf or other exclusive cards use mostly private cards provided by manufacturer with setting in computers and sometimes communication converters.

Set communication connection such as fieldbus, profibus, etc. with referring to manuals provided by manufacturers.

3.4.1.5 OPC  XE "OPC" 
OPC Communications stand for mutual communications between programs on Windows operating systems which Send data to the monitor or communication server by communicating with OPC server program and main OPC client program (OpcClient.exe).

Refer to each OPC server program instruction for OPC server usage and use main OPC client programs with related Help.
3.4.2 Communication Settings  XE " Communication Settings " 
Communication server, developed on 000~255 ports randomly specified are designed to communicate with PLC and controllers.  You are able to set it with text or in communication servers displayed below.  The following dialog box <Figure 3-24> comes up by clicking on ‘Edit Port File’ button from File menu items in the communication server.
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<Figure 3- 24> Dialog Box to Select Communication Port
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<Figure 3- 25> Dialog Box to Edit Communication Files
<Figure 3-25> appears to set whether to use ports, threads and types of protocols and reading, etc. by clicking on the communication port to modify in <Figure 3-24>.

Each factor in <Figure 3-25> to modify communication files is the following in <Table 3-2>.

	Editing Factor 
	Setting Method 

	Port No.
	Port numbers between 0~255 specified  in port selection

	Port Enable
	Whether to currently use the port

	Use Thread
	Whether to use threads 

	Descriptions
	Comments for ports, Not necessary to input.

	Read Cycle
	Input mSec as a unit for time intervals to read each read item.

	Write Cycle 
	Input Msec as a unit for time intervals to output accumulated commands in write command buffers.

	DEVICE
	Input communication port numbers, TCP/IP address, speed, etc. 
(Refer to the chapter 4.2.1)

	Protocol
	Select created communication protocols. (Refer to chapter 3.4.2.2)

	Option
	Input additionally needed contents for each protocol

	WORD, FLOAT, DWORD, STRING Memory Size
	Input the size of the communication memory using numbers. 

	Read TimeOut
	Maximum waiting time from sending a read command to get all data.

	Write TimeOut
	Maximum waiting time from a write command. to a signal displaying the command is completely written 

	Modem Option...
	Settings to read remote data via modem (Refer to 3.4.2.3) 

	Line Dual
	Settings to communicate with spare lines in case of errors on standard ones. (Refer to chapter 3.4.2.4) 

	Computer Dual
	Settings to monitor and control 2 computers with a line 
(Refer to chapter 3.4.2.5) 

	Settings for Read Type
	Method settings to read specific machine areas via communication memory (Refer to chapter 3.4.2.6) 


<Table 3- 2> Setting Method for each factor in Dialog Box to edit communication file
3.4.2.1 Device Settings  XE " Device Settings "   XE "DEVICE" 
Users are able to set devices depending on protocol types as in the following <Figure 3-3>.
	Device Types 
	Descriptions 

	None
	Mainly Available in communication by computer internal card, field bus, floppy bus, etc. 

	Com Port 
	Used the most for RS-232/422/485 communication 

	Modem
	Available to communicate with common modem(Com Port used for leased line modem)

	TCP/IP, UDP/IP
	Available for network communication via LAN, etc. 

	TeleDevice
	Available to use machines with Modem-Device

	NetClient
	Available when communication servers running as network client are used 

for network repeaters 

	Shared Memory 
	Run programs created by communication servers and users via specified shared memory. 


<Table 3- 3> Comment to Set Device for Each Type
<Figure 3-26> to set port devices appears by clicking on the [image: image346.png]


 button in <Figure 3-25>.
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<Figure 3- 26> Dialog Box to Set Port Device
You can mainly use Tx, Rx flow control, RTS/DTR End Delay and Start Delay in <Figure 3-26> in 485 communications and input initialization and connection commands and connect signal timeout using [image: image348.png]Option.



button in TeleDevice.

TeleDevice is for communication equipment (radio, etc.) to command initiations and connections in communication connections and in case of communications between OPC Client Main and Communication Server uses the shared memory required to input the set name in the main program.
3.4.2.2 Protocol Settings  XE " Protocol Settings " 
	Protocol settings to use are available in <Figure 3-27> using [image: image349.bmp] button on protocol input editor screen in <Figure 3-25> to edit communication files.

If you want to use protocols unlisted in <Figure 3-27>, create DLL Files with tool kit or add them by contact ing the development company.
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<Figure 3- 27> Example of Protocol list


3.4.2.3 Dialup Settings  XE " Dialup Settings " 
Users are able to set phone numbers to connect, connection cycles, time, whether to connect automatically, etc. in <Figure 3-28> by clicking on [image: image351.png]Dialup Settings



 button in the dialog box to edit port files.
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<Figure 3- 28> Dialog Box for Dialup Settings
Dialup Connection Settings are available when communication devices use MODEM1 ~ MODEM256. 
Communication servers keep calling phone numbers to connect every 60 minute (an hour), communicating with it for 60 seconds (1minute) and hanging up depending on connection cycles such as 60 minutes, 60 seconds or automatic connection.
3.4.2.4 Line Duplex  XE " Line Duplex " 
Line Duplex is to communicate with reserve devices and protocols in case of the standard devices (lines) specified with a condition of automatic transfer.

Check out ‘Duplex able’ on Duplex Line Settings Area in the dialog box to edit communication files and click on [image: image353.png]Option.



 button, <Figure 3-29> to set ears.

Set Condition of line change, Secondary Device and Protocol to use, etc. in <Figure 3-29> for duplex available.
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<Figure 3- 29> Dialog Box to set Line Duplex
3.4.2.5 Computer Duplex  XE " Computer Duplex " 
The <Figure 3-30> comes up by pressing [image: image355.png]Option.



 button with checking ‘Use Duplex’ from Computer Duplex Settings Area in the Dialog Box to edit port files.
Computer Computer is available in case of setting whether to use threads, anotuer computer information, Timeouts to change, etc. in <Figure 3-30>.
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<Figure 3- 30> Dialog Box to set Computer Duplex
Duplex Computer Systems which 2 computers use for monitor and control on a line is are designed to communicate with other s systems in case the current connected computers are in transfer conditions.

In that case, systems not directly communicated share communication data via IP address or service ports specified from Computer Duplex Settings.

3.4.2.6 Set Read Method  XE " Set Read Method " 
Methods to read the specific area for equipment via communication memories are either to input it (not available depending on protocol types) using the [image: image357.png]


 button, or to directly input it on editor areas below.

The setting follows in the order of READ (FLOAT, DWORD, STRING), equipment station numbers, memory types for each area, the start address to read, memory storage locations for communication servers, sizes to read as below.

	Input Example)
	READ, 255, DI,  2,  2,  2,

	
	FLOAT, 255, AI, 14, 58, 4, 

	
	DWORD, 255, AI,  0, 0, 4,

	
	...


PLC or Controller address to read possible to be listed can be different according to communication protocol types as above.
‘Read Command’ is used to save read data in WORD Memory and each command such as FLOAT, DWORD and STRING Command’ store them in its memory for example FLOAT, DWORK and STRING Memory.

3.5 Communication Status Signal 
The communication server running with connecting to the monitor program displays the current communication status on the monitor program using the communication status signal.

The communication status stored in System Memory of the communication server can be checked with analog or digital tags.  Set ports and addresses as follows <Table 3-4> to display the current communication status into digital input tag, etc.
 XE " Communication Status Signal " 
	PORT 
	500
	Port Number + 1 (If Port number is 1,then 501)

	ADDRESS
	0000
	ON – normal communication, OFF – abnormal communication 


<Table 3- 4> Setting Factor for Input Tag to Check Communication State
<Table 3-5> shows the addresses and contents of status signals for main communication state saved in SYSTEM Memory.
	Port 
	Addr. 
	Motion 
	Remark 

	500 +

Port No. 
	0000
	ON- Normal, OFF-Abnormal
	Immediate reactions in case of communication timeout

	
	0001
	ON- Normal, OFF- Abnormal
	Responds to 5 timeouts occurring continuously

	
	0002
	ON- Normal, OFF- Abnormal
	Responds to 10 timeouts occurring continuously

	
	0003
	ON- Normal, OFF- Abnormal
	Responds to 20 timeouts occurring continuously

	
	0004
	ON- Normal, OFF- Abnormal
	Responds to 30 timeouts occurring continuously

	
	0010
	ON- during dial-up connection
	Displays whether to dial up connection

	
	0020
	ON- Reserve Device,
OFF- Basic Device
	Device status currently being used in using duplex options

	
	0030
	ON- Timeout, OFF-Normal
	ON in case of communication time out

	
	0031
	ON-Bad Code, OFF-Normal
	ON in case of bad communication code

	
	0040
	ON- Relative Server Recognition,
OFF-Relative server check not available
	When recognizing the relative server in using duplex PC.

	
	0041
	ON- This is the Master Computer
	This is the Master in using duplex PC.

	
	0042
	ON- The relative computer is the Master
	The relative computer is the Master in using duplex PC.

	
	0043
	ON- Timeout occurring on this computer
	Whether timeout occurs or not in this computer

with duplex PC.

	
	0044
	ON- Timeout occurring on the relative computer
	Whether timeout occurs or not in the relative computer with duplex PC.


<Table 3- 5> Address and Contents of Status Signals
for Main Communication State Signal Stored in System Memory
<Table 3-6> shows the addresses and contents of success or failure rate for communication.

	Port
	Addr.
	Contents 
	Remarks 

	500 +

Port No.
	0005
	Communication Success Rate
	Success Rate x 100 , 
Thus 0 ~ 10000 (100 %) Values 

	
	0006
	Communication Failure Rate
	Failure Rate x 100 , 
Thus 0 ~ 10000 (100 %) Values

	
	0007
	Success Rate for Basic 

Device Communication 
	Success Rate x 100 , 
Thus 0 ~ 10000 (100 %) Values

	
	0008
	Success Rate for Reserve 

Device Communication
	Failure Rate x 100 , 
Thus 0 ~ 10000 (100 %) Values


<Table 3- 6> Address and Contents of Success or Failure Rate for Communication
The following <Table 3-7> is output addresses and Contents for modem connection or reserve/basic device conversion.
 XE " modem connection " 

 XE " reserve/basic device conversion " 
	Port
	Addr.
	Extra1
	Description 
	Remarks

	500 + 
Port No.
	0010
	#DO#
	Modem Connection /Closing with ON/OFF button
	Device=Modem 

	
	0020
	
	Reserve/Basic Device Connection with ON/OFF button
	


<Table 3- 7> Output Address and Contents for Modem Connection or Reserve/Basic Device Conversion.
<Empty Page>
Chapter4. Network Program
 XE " Network Program "  XE " Network " 
AUTOBASE Network Program available to monitor or run contents supervised with AUTOBASE includes network memory server/client, network server/client, etc.
4.1 Network Memory Server / Client  

Network Memory Server/Client as a method of sharing communication servers configures network systems.  XE " Network Memory Server / Client " 
The configuration is as in the following <Figure 4-1> and the maximum 256 clients can connect to the network memory server.
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<Figure 4- 1> Network Memory Server / Client Diagram

4.1.1 Network Memory Server Settings

Network Memory Server Settings is to read the communication memory read from communication servers from another one.  XE " Network Memory Server Settings " 
You are able to set network memory servers in <Figure 4-2> by clicking on ‘View | Network Memory Server’ from the communication server.
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<Figure 4- 2> Example of Network Memory Server State Screen

The following dialog box <Figure 4-3> to set network memory servers appears by double clicking on the left mouse button after selecting numbers you want between connection 0~255 in <Figure 4-2>.
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<Figure 4- 3> Dialog Box Network Memory Server Connection Settings 

Select one of NULL Modem, TCP/IP, UDP/IP for the connection methods of network memory servers.
Additionally, depending on connection methods, input serial port settings, TCP/IP, UDP/IP service port numbers and set Send Delay and Item counts for one time.

4.1.2 Network Memory Client Settings

Network Memory Client can be set with ‘Edit Communication File’ from Communication Servers.  XE " Network Memory Client Settings " 
Choose ‘File | Edit Port File’ menu from Communication Server and edit communication files as the following <Figure 4-4> to set Network Memory Client.
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<Figure 4- 4> Example to Edit Communication File of Network Memory Client
Input connection methods (one of NULL modem, TCP/IP and UDP/IP) set in server, communication speed, IP addresses, service ports, etc. for Device and read lines in read areas and set ‘DLL-Network Client’ for Protocol in <Figure 4-4>.
Input communication port numbers (0~255) to read from server computers in protocol options and ones as much as set in servers in WORD, FLOAT, DWORD memory.
If you set the Network Memory Client such as <Figure 4-4>, you can monitor the communication memory of servers read from clients, send control commands from them to servers and do monitoring , control, alarms settings, report output, etc. by setting different tags in client systems.

4.2 Network Server / Client Configuration 

Network Server/Client are able to create network systems in single or double environments, and the maximum number of clients available to connect to one network server is 256.

The following <Figure 4-5> displays the Network Server and Client Program Diagram.
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<Figure 4- 5> Network Server / Client Program Diagram
 XE " Network Server/Client Configuration "
4.3 Network Server

The Network Server can be set on one of a single server used in case of one server, dual primary server and dual secondary server.

 XE "Stand Alone"

 XE "Primary"

 XE "Secondary"
4.3.1 Running Network Server

The Network Server Program as in the following <Figure 4-6> starts to run using AUTOBASE Windows or ‘Network Server’ ([image: image363.png]


) button from Start Program.
Also, you can register the Network Server along with monitor programs in the Start Program or use scripts in the monitor program to run it.
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<Figure 4- 6> Example of Network Server Program Running 

The Network Server consists of the program name display, text menus, Windows internal area, etc. and use general shortcuts.

4.3.2 Function Description for Each Text Menu XE " Menu " 
The Text Menu on the network server includes File, View, Config, Window and Help.

4.3.2.1 File Menu Item

The File Menu Items contain text items to activate this computer, another computer, exit, etc. as in the following <Figure 4-7>.
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<Figure 4- 7> File Menu Items of Network Server

Activate this computer or another computer button is for dual network, or activates the specified server in regular communication status.

Clicking on Exit button closes the Network Server Program.
4.3.2.2 View Menu Items 

View Menu Items contains sub menus such as Server State, System Memory, Client State, View Communication Code and Network Connection as below <Figure 4-8>.
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<Figure 4- 8> View Menu Items of Network Server

1) Server State  XE " Server State "
The <Figure 4-6> displays connection state for set network server, connection names, monitor status, etc. by selecting Server State button from View Menu.

2) System Memory  XE " System Memory "
Clicking on ‘System Memory’ button opens <Figure 4-9> showing duplex connection status, activation for each server, connection status for the network connection node 0~F(16th node) address, etc. The following <Table 4-1> is addresses and contents for system memory status of the network server.
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<Figure 4- 9> Example of System Memory for Network Server
	Address
	Contents
	Remarks 

	0000
	Connection State of Primary and Secondary server in duplex system 
	1 = Connected 

0 = Disconnected 

	0001
	This server is active in duplex system 
	1 = Active 

0 = Inactive 

	0002
	The relative server is active in duplex system. 
	

	0160 ~

016F
	The basic line state for network connection Node 0

~

The basic line state for network connection Node F
	1 = Connection 

0 = Bad 

	0170 ~

017F
	The reserve line state for network connection Node 0

~

The reserve line state for network connection Node F
	


<Table 4- 1> Addresses and Contents for System Memory Status of the Network Server
3) Client State XE " Client State "
By pressing ‘Client State’ from View Menu, <Figure 4-10> appears displaying the connected client IP address, connection status, the number of receiving/transmitting frames, etc.
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<Figure 4- 10> Example of Client State View
4) Communication Code  XE " Communication Code "
As shown in <Figure 4-11>, these two view windows, one is the transmitting code using servers and the other is receiving code from each client or other servers can be displayed by clicking on Communication Code button from View Menu.
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<Figure 4- 11> Example to View Communication Code
5) Network Connection  XE " Network Connection "
If you click on Network Connection button from View Menu, <Figure 4-12> appears to show the basic IP and reserve IP for each server/client input network connection settings and the connection status.
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<Figure 4- 12> Example to View Network Connection
4.3.2.3 Config Items
	Config Items contain server, time synchronization, network connection and settings as displayed in <Figure 4-13>.
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<Figure 4- 13> Configuration Setting Item of 
Network Server


1) Config Settings  XE " Config Settings "
The dialog box <Figure 4-14> appears using Config Server button to set server names and types, automatic server switching conditions, switching lists, etc.
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<Figure 4- 14> Example for dialog box for Config Server
The server name is input with English or Korean alphabetic letter, numbers, etc. and the server type is chosen in Single, Dual Primary and Dual Secondary Server according to system installation state.  Select Automatic Server Switching Condition and Switching Lists when Dual Primary Server or Dual Secondary Server is set in server types and input communication ports in port settings to use between servers and clients.

Additionally, it is possible to specify whether to share the communication memory with network server programs depending on clicking on [image: image373.png]¥ Support PLC_SCAN memory



 in the following <Figure 4-14>.
	Reference)


	Generally, the communication memory shares the memory with communication connection servers/ clients and network servers/clients is used for synchronization of servers, tag setting values and alarming.  That is, servers and client systems are configured using communication servers / clients and network servers/ clients at the same time.


2) Time Synchronization  XE " Time Synchronization "
Time Synchronization means that time for servers or client systems is synchronized at a specific time or manually by users.
Selecting Time Synchronization button brings up <Figure 4-15> as shown below.
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<Figure 4- 15> Example of Dialog Box for Time Synchronization
If you click to check ‘Active’ (✔) button in <Figure 4-15> and set synchronization cycles (daily, hourly or minutely) or time, the entire system time (servers and clients) is synchronized to the set server time at any specified time.
The entire system time is synchronized to the current server time by pressing [image: image375.png]Set Now



 in <Figure 4-15>.
3) Network Connection  XE " Network Connection "
Choosing Network Connection button from Configuration opens up the dialog box <Figure 4-16> to input the primary and secondary IP address of every server/client system connected.
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<Figure 4- 16> Example of Dialog Box for Network Connection
The dialog box to modify (add) network node as shown <Figure 4-17> appears available to set names, the primary and secondary IP of the network node, whether to supply PLC_SCAN memory, etc. using [image: image377.png]Add



 or [image: image378.png]Modify



 button in <Figure 4-16>.
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<Figure 4- 17> Example of Dialog Box to Modify Network Node
Inputting all servers (including own IP address) and client IP address connected is required to synchronize tags, alarms, time, etc. in Network Connection Settings.

Also, set your own IP by clicking on [image: image380.png]Set Local



 for your IP address.
4.3.2.4 Window Menu Item
	Window Menu Items include sub menus such as Cascade, Tile Horizontally, Tile Vertically, Arrange Icons, Close and Close All displayed as <Figure 4-18>.
These menus and MDI Windows have same instructions to use.
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<Figure 4- 18> Window Menu Item


4.3.2.5 Help Menu Item 

Help Menu Items contain sub menus for program information possible to check out the version information of the network servers.
4.4 Network Client  XE " Network Client "
Network Client Programs interpret different data received from servers by connecting to network servers and transmit control commands sent from monitor programs to servers.

4.4.1 Running Network Client 

Network client programs run as in the followings <Figure 4-19> by selecting ‘Network Client’ ([image: image382.png]


) button from AUTOBASE Window or Start Program, registering with monitor programs in Start Program, or using scripts in monitor programs.

The network client consists of the program name display, text menus, window internal areas, etc. and runs generally using shortcut keys.
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<Figure 4- 19> Example of Running Network Client Program
4.4.2 Description for Each Text Menu  XE " Menu "
The text menu for the network client contains File, View, Config, Window and Help.

4.4.2.1 File Menu Items 

File Menu Items contain submenus to close the network client program.
4.4.2.2 View Menu Items 

	View Menu Items include submenus such as Servers, Communication Code, Network Connection as shown <Figure 4-20>.
1) Servers  XE " Servers"
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<Figure 4- 20> View Menu Items for Network Client


Clicking on ‘Servers’ button from View Menu displays the connection status of the connected network server, connected names, etc. in <Figure 4-19>.
2) Communication Code  XE " Communication Code "
If you select Communication Code button, you can see the window divided into two windows, transmitting and receiving code window. ‘Communication Code’ menu is used in network server/client programs as well.
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<Figure 4- 21> Example to View Communication Code
3) Network Connection Status  XE " Network Connection Status "
Choosing ‘Network Connection’ button brings up <Figure 4-22> to display each primary and secondary IP or connection status input in network connection settings.

Also the menu is used in the network server/client programs, too.
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<Figure 4- 22> Example to View Network Connection Status
4.4.2.3 Config Menu Items
	The Config Menu Items consist of Config Settings, Network Connection and Settings as shown <Figure 4-23>.
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<Figure 4- 23> Configuration Menu Items of Network Client


1) Config Client  XE " Config Client "
	Selecting ‘Config Client’ button from Configuration opens up the dialog box <Figure 4-24> available to set UDP/IP, TCP/IP communication service ports to communicate with servers, etc.
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<Figure 4- 24> Example of Dialog Box for Config Client


2) Network Connection  XE " Network Connection "
Input the primary and the secondary IP of every connected server/client in the dialog box <Figure 4-25> coming up using ‘Network Connection’ button from Config.
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<Figure 4- 25> Example of Dialog Box for Network Connection
By pressing [image: image390.png]Add



 or [image: image391.png]Modify



 button in <Figure 4-25>, the dialog box to add (modify) network nodes appears available to set names, the primary and the secondary IP of network nodes, whether to use PLC_SCAN memory supply, etc.
Input every connected server and client IP addresses in the dialog box, Network Connection Settings, to synchronize tag, alarms, time, etc. XE "Set Local " 
Pressing [image: image392.png]Set Local



 button sets my computer (Client) address with your own IP.

‘Network Connection Settings’ menu is used in Network Server / Client Programs as well.

	3) Settings 

The dialog box <Figure 4-26> by clicking on ‘Settings’ button appears to set whether to switch the current tag values and alarm status values.

Pressing ‘Exchange Tag Current’ buttons is to synchronize the current analog or digital tag values on the connected servers with the client ones. XE " Settings "
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<Figure 4- 26> Example of Dialog
Box for Settings


4.4.2.4 Windows Menu Items
	Windows Menu Items for network clients contain submenus such as Cascade, Tile Horizontally, Tile Vertically, Arrange Icons and Close All and have same instructions with the own MDI Window manual.
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<Figure 4- 27> Window Menu Items


4.4.2.5 Help Menu Items 

Help Menu Items include submenus for program information available to check network client versions.

<Empty Page>
<Empty Page>
Chapter5. SMS Manager 

 XE " SMS Manager " 

 XE "alarm" 
The SMS manager being used when necessary to transmit the alarm contents occurred to your cellular phone requires you to connect your cellular phones to computer serials or USB communication ports. Systems need to be connected to the internet in case of using voice messages and the following <Figure 5-1> is an example of running the SMS manager.
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<Figure 5- 1> Example of Running the SMS Manager
5.1 Running the SMS Manager

Clicking on ‘SMS Manager’ ([image: image396.png]


) button from AUTOBASE Windows or the start program begins to run the message manager.

And this program can be run by registering with the monitor program together or using scripts after finishing all editing works.
5.2 Whole Figure and Shortcuts Descriptions 

The SMS manager contains the program name display, text menus, Window internal areas, menu buttons, etc. and generally uses shortcut keys.

5.2.1 Figure Descriptions

Shortcut Descriptions as shown in <Figure 5-1> appear by running the SMS manager.

5.2.1.1 Program Name Display

This is an original Windows feature to display names on the screen above.

5.2.1.2 Text Menu XE " Menu "
Text Menus including File, View, Config, Window and Help can be selected by pressing the left mouse button on the text you want to choose, or using arrow or ‘Enter’ key with holding’ ALT’ or ‘F10’ down.
5.2.1.3 Menu Button XE " Menu Button "
Menu Buttons are displayed under the screen of the SMS manager, etc. with texts.

5.2.1.4 Shortcut Button  XE " Shortcut Button "
Shortcut buttons such as [image: image397.png]Autobase



, [image: image398.png]User Message



, etc. are shown on the right screen.

5.2.1.5 Windows Internal Area

Window Internal Areas displaying contents for the SMS manager are changed based on types of screens.
5.2.2 Shortcuts Descriptions  XE " Shortcuts " 
The following <Table 5-1> displays shortcut keys used in the SMS manager.
	Shortcut Keys
	Description

	ENTER
	Select functions and check menus.

	ESC
	Cancel functions and Move back to previous menus.

	SYMBOL 225 \f "Wingdings",SYMBOL 226 \f "Wingdings",SYMBOL 223 \f "Wingdings",SYMBOL 224 \f "Wingdings" (Arrow Keys)
	Move between menus.

	ALT, F10
	Move to text menus.

	SHIFT+F5
	Arrange MDI Windows in cascade.

	CTRL+F4
	Close currently selected MDI windows.

	PGUP, PGDN, Other FUNCTION Keys
	Used differently based on each screen.

	Other Basic Shortcuts
	Basic shortcut keys on Windows


<Table 5- 1> Shortcut Keys for SMS Manager
5.3 Description for Each Menu Item  XE " Menu "
The Text Menu Items include File, View, Configuration, Help, etc.
5.3.1 File Menu Item
	The File Menu Items contain Send Manual Message, Test message, SMS Message Queue, Exit and current open Window buttons as displayed in <Figure 5-2>.
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<Figure 5- 2> File Menu Items for SMS Manager


5.3.1.1 Send Manual Message  XE " Send Manual Message "
Clicking on Send Manual Message or [image: image400.png]User Message



 button opens up the dialog box <Figure 5-3> available to send messages using [image: image401.png]Send SMS



 button after selecting users and inputting sentences to send.
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<Figure 5- 3> Example of Dialog Box to Send Manual Messages
5.3.1.2 Send Test Message   XE " Send Test Message "
	The dialog box <Figure 5-4> comes up by choosing Send Test Message button from Text Menu items. 

Sending test message is available by clicking on [image: image403.png]Send SMS



button after inputting Alarm Priority, Tag Types and Description, Message to send, etc. on the assumption that alarms would occur depending on the conditions mentioned above.
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<Figure 5- 4> Example of Dialog Box 
to Send Test Messages


5.3.1.3 SMS Message Queue  XE " Send Message Queue "
This menu displays message contents left in the memory in order in the dialog box <Figure 5-5> available to check and cancel specific messages.
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<Figure 5- 5> Example of Dialog Box to view SMS Message Queue
5.3.1.4 Exit  XE " Exit " 
You can close the SMS manager by selecting Exit button from File menu items.

5.3.1.5 Open Windows Menu  XE " Open Windows Menu "
Users are able to activate User Settings Screen, View Message Data and Communication Code, etc. by choosing open Windows below File menu.

5.3.2 View Menu Item 

	Selecting View Menu brings up <Figure 5-6> containing menu items such as User Lists, Communication Code, SMS Called Lists, Web Service State and Main Program.
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<Figure 5- 6> View Menu Items of the SMS Manager


5.3.2.1 User Lists  XE " User Lists "
Click on ‘User Lists’ button from View Menu Items to display the dialog box <Figure 5-7> showing usernames, cellular phone numbers, status, retry count, etc.
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<Figure 5- 7> Example of User Setting Screen
Double clicking on the left mouse button with selecting specific users in <Figure 5-7> brings up the user settings dialog box <Figure 5-8> possible to set whether to use user’s information, user names, phone numbers, sending conditions, Alarm Priorities to send messages, message type, etc.  Also, the SMS manager can set a maximum number of 256 users to receive messages.
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<Figure 5- 8> Example of Dialog Box for User Settings
5.3.2.2 Communication Code  XE " Communication Code "
<Figure 5-9> to display Communication Code appears by pressing Communication Code button from View menu items.
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<Figure 5- 9> Example of Communication Code Screen
This Screen divided into the sending and the receiving code windows shows Communication Code sent to and received from cell phones in Hex, ASCII or Decimal format when the transmission system is set to be directly connected (Serials, etc.).
Also when you click on ‘Pause’ button, the display for viewing will pause. XE "sending code window " 

 XE "receiving code window" 
5.3.2.3 SMS Sended Lists  XE " SMS Sended Lists " 
When you click on ‘SMS Sended Lists’ button from View menu items, it will show the display for viewing for each date as below <Figure 5-10>.
[image: image410.png]* SMS Manager - [Sms Sended Lists]
w2 File View Config Mindow Help .3]

Tine User Name Phane Mum/TP No SendData Main Program
1743 Anchen 010-123-4567 55 Data Send Ta Web Service
7e4s Anchen 010-123-4567 55 Data Send Ta Wieb Service
1708s3 Anchen 010-123-4567 55 Data Send Ta Wieb Service
G Ancren 010-123-4567 55 Data Send Ta Wieb Service. T pisssags Format
I7L16 Ancren 010-123-4567 55 Data Send Ta Wieb Service

w21 Anden 010-123-4567 55 Data Send Ta Web Service User Settings

Manual Message

Alarm Prcrty
Settings
S5 EnablelF12]

Close [Esc] | Delste[Del] Print | Print Font





<Figure 5- 10> Example for Viewing Message Transmission Record
You can delete or print the records of specified dates using [image: image411.png]Delete [Del]



 or [image: image412.png]Print



 button.

And setting font types and sizes to print is available by clicking on [image: image413.png]Print Font



 as well.

5.3.2.4 Web Service State  XE " Web Service State "
Web Service State appears as in the following <Figure 5-11> by clicking Web Service State button.
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<Figure 5- 11> Example of Viewing Web Service State
Site names in <Figure 5-11> show the primary and the secondary sites to transfer web service messages set in ‘Config | Communication Port Settings’.
5.3.2.5 Main Program  XE " Main Program "
Users are able to move Windows focus to the Main program or run it by choosing ‘Main Program’ button from View menu items.

5.3.3 Config Menu Item
	This menu items include user settings, alarm priority settings, message format, communication port settings, settings as displayed in <Figure 5-12>.
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<Figure 5- 12> Configuration Menu Item of 
SMS Manager


5.3.3.1 User Settings  XE " User Settings "
The dialog box <Figure 5-13> as below to show 256 users’ names and setting state appears using User Settings button.
Double clicking the left mouse button with selecting users in <Figure 5-13> or pressing [image: image416.png]Modify



 button, the dialog box <Figure 5-8> comes up to set whether to select users, user names, cell phone numbers, transfer conditions, alarm priority to send messages, etc.
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<Figure 5- 13> Example of Dialog Box to Select Users in Settings
5.3.3.2 Alarm Priority Settings  XE " Alarm Priority Settings "
Pressing the Alarm Priority Settings button from Config menu items brings up <Figure 5-14> to set the alarm priority for each user.
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<Figure 5- 14> Example of Dialog Box to Set Alarm Priority 

The message manager sends text messages to relevant user cell phones when priority alarms occur specified in the monitor program (Depending on user settings, DI tag values may need to be ON together.) and alarm priorities for specific users are set in <Figure 5-14>.
5.3.3.3 Message Format  XE " Message Format "
<Figure 5-15> comes up by choosing Send Message Format button from Configuration Menu Items to set messages to send.
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<Figure 5- 15> Example of Dialog Box to Set Message Formats
There are two types of settings in send messages format. : Default and User Defined.  The default settings process ‘send messages’ in the order of time, tag comments and messages.  Users are able to input directly ‘send messages’ in edit boxes and each button to edit message contents in User Settings. Help displays how to input ‘send message’ in detail.

5.3.3.4 Communication Port Settings  XE " Communication Port Settings "
Clicking ‘Communication Port Settings’ button brings up the dialog box <Figure 5-16>.
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<Figure 5- 16> Example of Dialog Box to Set Transmit Systems

You set message transfer systems by setting transfer system type including ‘direct’, ’web service’ and ‘transmit to server(server/client structure)’, serial ports/ speed, network settings, web service, etc. in <Figure 5-16>.
5.3.3.5 Settings  XE " Settings "
You can set retrial times, delay time, maximum number of characters to send, message type, phone numbers to receive messages, PCS model, etc. for message systems in <Figure 5-17> appearing by clicking ‘Config’ button from Configuration Menu items.

Do not input anything or input cellular phone numbers connected to the system for phone numbers to receive messages. XE " retrial times "

 XE "phone number to receive message"
[image: image421.png]Setilings,

Retral tines

Default Retry.

hen Line Error

Delaytimes Tineaut

Between Liser e Contral Command
st [5 sec Message Confirm

Max Character Length Message Type

=
=
g

o0 ot

Phane number to receive message
—— [ CallEnablelF12]

PCS(COMA) Model

Err—





<Figure 5- 17> Example of Dialog Box for Settings
5.3.4 Windows Menu Item  XE " Windows Menu "
	This menu items contain submenus such as Cascade, Tile Horizontally, Tile Vertically, Arrange Icons, Close and Close All and have a same instruction with the original MDI Windows function.
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<Figure 5- 18> Windows Menu Item


5.3.5 Help Menu Item  XE " Help Menu "
You can check the version information by clicking on ‘About’ item for SMS manager from Help menu items.
<Empty Page>

Chapter 6. Line Printer Manager

 XE " Line Print Manager " 

 XE "alarm" 
Line Printer Manager usually use dot printers to print directly alarms raised in the monitor program to printer porters. The following <Figure 6-1> displays line printer manager running.
The <Figure 6-1> displays line printer manager running.
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<Figure 6- 1> Line Printer Manager Running
6.1 Running Line Printer Manager 

Clicking on ‘Line Printer Manager’ ([image: image424.png]


) button makes Line Printer Manager run. Also, after editing, you can run this by registering with monitor programs in Window Start Program or using scripts in monitor programs.
6.2 Whole Figure and Shortcuts Descriptions 

Line Printer Manager contains program name display, Internal Windows and program menu options such as File, Config, and Help.
The internal Windows displays the setting status and numbers of remaining alarms to print of Line Printer Manager as shown <Figure 6-1>.

The following <Table 6-1> shows the shortcut keys used in Line Printer Manager.
	Shortcuts 
	Functions 

	ENTER
	Select functions and check menus. 

	ESC
	Cancel functions and move to the previous menus. 

	SYMBOL 225 \f "Wingdings",SYMBOL 226 \f "Wingdings",SYMBOL 223 \f "Wingdings",SYMBOL 224 \f "Wingdings" (Arrow Keys)
	Move the internal Window up/down/ left/ right or between menus. 

	ALT, F10 
	Move to the menu bar. 

	ALT+F4 
	Close programs. 

	Windows Default Shortcuts 
	Default shortcuts functions 


<Table 6- 1> Shortcuts Descriptions of Line Printer Manager
6.3 Descriptions for Each Menu  XE " Menu " 
The menu bar under Line Printer Manager contains File, Config and Help menu.

6.3.1 File Menu

File menu has a submenu available to exit.
	6.3.2 Config menu

The Config Menu contains submenus named Port Settings, Display Formats and Control Commands as shown <Figure 6-2>.
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<Figure 6- 2> Configuration Settings Menu


6.3.2.1 Port Settings

Clicking on port settings menu from Config opens The Port Settings dialog box in the following <Figure 6-3> to set whether to print, how to print dates, ports and speed with timer.
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<Figure 6- 3> Example of Dialog Box for Print Port Settings in Line Printer Manager
6.3.2.2 Display Formats  XE " Display Formats "
<Figure 6-4> appears by selecting ‘Display Formats’ menu.
There are Default and User Defined in Display Format.  ‘Default’ setting is configured to set the intervals in order of dates, time, tags and tag explanation.  Or you are able to set the interval by inputting the contents to print in the editor box by using [image: image427.png]


, [image: image428.png]Date2



, [image: image429.png]


, [image: image430.png]


, [image: image431.png]


, [image: image432.png]


, [image: image433.png]Msg40



 buttons
[image: image434.png]Display Formats.

Display Format
€ Defaul

& ey defined

o e
oue | ower | e | | oe | _mo | _mow

[e0Date] e e{Tag] E{Desc] eltal





<Figure 6- 4> Example of Dialog Box for Printing Interval Settings
6.3.2.3 Control Commands 

Setting ‘Control Commands’ (ESC Control Commands) helps you print alarms with different colors to the color printer, or change the font or font size according to each alarm type.
Use <Figure 6-5> below to set the command.
For more information about how to input the control commands, refer to the instruction manual provided when buying printers. XE " Control Commands"
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<Figure 6- 5> Example of Dialog Box for Control Commands Settings for Each Alarm Types
6.3.3 Help Menu Items 

Help Menu Items contain the submenu named ‘About’ to check the Line Printer Manager version.
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Chapter 7. Watchdog

 XE " Watchdog " 
‘Watchdog’ is created to run specific programs again in case programs would be closed due to bugs, program instability, etc.  <Figure 7-1> displays the watchdog running.
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<Figure 7- 1> Watchdog Program Running
7.1 Run Watchdog 

Select and run the ‘watchdog’ ([image: image437.png]


) in AutoBase Window or Start Program. 

You can run the ‘watchdog’ by registering it in Start Program after editing or using the scripts of Monitor Program.
7.2 Whole Figure and Shortcuts Descriptions
Watchdog consists of the program display, menu bars, internal Windows, etc. and displays program names to use as watchdog, set points, current values, program start time and  whether to use functions or not.  The following <Table 7-1> shows shortcut keys available in watchdog.

	Shortcuts
	Functions 

	ENTER
	Select functions and Check menus, etc.

	ESC
	Cancel functions and move to the previous menus

	SYMBOL 225 \f "Wingdings",SYMBOL 226 \f "Wingdings",SYMBOL 223 \f "Wingdings",SYMBOL 224 \f "Wingdings" (arrow keys)
	Move the internal Window up/down/ left/ right or between menus

	ALT, F10
	Move to text menu

	ALT+F4
	Close Programs

	Default shortcuts for Windows
	Default shortcuts for Windows


<Table 7- 1> Shortcuts Summay for Watchdog
7.3 Menu Bar Description  XE " Menu " 
The menu bar includes File and View.

7.3.1 File Menu 

The File Menu contains the submenu ‘Exit’ available to close the watchdog program.
7.3.2 View Menu 

The View Menu incluses submenus such as Log File and Hide as below.
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<Figure 7- 2> Watchdog View Menu Items

7.3.2.1 Log List 

Choose ‘Log List’ from View Menu to check logged informtation of the Watchdog program in Notepad in the following <Figure 7-3>.
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<Figure 7- 3> Example to View Log File in Watchdog
7.3.2.2 Hide 

You can hide the Watchdog Program by clicking on ‘Hide’ option from View Menu.

Selecting [image: image440.png]


 icon in your system tray on Windows displays the Watchdog program again.
7.4 Shortcut Menus  XE " Shortcut Menus "
Shortcut menus such as ‘Run Program’ and ‘Properties’ options appear as below <Figure 7-4> by clicking on the right mouse button on the program registered in Watchdog.
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<Figure 7- 4> Watchdog Shortcut Menu

7.4.1 Run Selected Programs 

Pressing the selected programs from the shortcut menu is available to run each one registered in Watchdog.

7.4.2 Modify Properties 

Select ‘Modify Property’ option from the Shortcut Menu to open up the dialog box to modify properties in the following <Figure 7-5> available to set timer and whether or not to be active of Watchdog functions.
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<Figure 7- 5> Example of the Dialog Box to Modify Properities of Watchdog
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Chapter 8. Running Server 
 XE "Running Server"
Selecting ‘Running Server’ program makes it possible to save data, Integrate database, share servers, etc. and the following <Figure 8-1> displays the home screen.

[image: image443.png]



<Figure 8- 1> Home Screen of Running Server
8.1 Running Server 

Clicking on ‘Running Server’([image: image444.png]


) button is available to run Running Program in Windows or Start Program.

Register ‘Running Server’ in Windows or Start Program or use scripts in the monitor program to run it.
8.2 2 Whole Figure and Shortcuts Descriptions 

‘Running Server’ program is made up of the program display, menu bars, internal Windows, etc. and is generally used with shortcut keys as shown in <Table 8-1>.
	Shortcuts
	Functions 

	ENTER
	Select functions and Check menus, etc.

	ESC
	Cancel functions and move to the previous menus

	SYMBOL 225 \f "Wingdings",SYMBOL 226 \f "Wingdings",SYMBOL 223 \f "Wingdings",SYMBOL 224 \f "Wingdings" (arrow keys)
	Move the internal Window up/down/ left/ right or between menus

	ALT, F10
	Move to the menu bar

	ALT+F4
	Close Programs

	Default shortcuts for Windows
	Default shortcuts for Windows


<Table 8- 1> Shortcuts Descriptions of Watchdog

8.3 Menu Bar Description  XE " Menu " 
The menu bar under ‘Running Server’ program contains File, View, Config and Help menu.

8.3.1 File Menu 

The File Menu has a submenu, ‘Exit’, to close the running server.

8.3.2 View Menu
	The View submenu contains items such as DB Integrations and Shared Server Status as displayed in <Figure 8-2>.
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<Figure 8- 2> View Submenus of the Running Server program


8.3.2.1 DB Integrations
‘DB Integrations’ is to calculate and display integral values of data, saved in database data, for previous and this year/month/day and time.

Selecting ‘DB Integration’ item from View Menu shows DB Integral Values for lists registered in <Figure 8-3>.
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<Figure 8- 3> Example of Dialog Box to View DB Integration Values

Clicking on ‘File | List Settings’ in <Figure 8-3> opens the dialog box <Figure 8-4> to add or delete some data to display DB Integration.
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<Figure 8- 4> Example of Dialog Box to set lists of DB Integration

The dialog box <Figure 8-5> appears by clicking on [image: image448.png]Add



 button from <Figure 8-4>. 
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<Figure 8- 5> Example of Dialog Box to Add Lists of DB Integration
DB Integration Lists can be added by selecting saved lists and integration tags in <Figure 8-5>. Saved List and Integration Column are configured from ‘Config | Database’ menu.
Select [image: image450.png]Delete



 button from <Figure 8-4> to delete the DB Integration lists from settings.

8.3.2.2 Shared Server Status
Shared server is a configuration designed for sharing data such as current values of systems connected via network. Select shared server from view for a dialog box as in <Figure 8-6> to view web server/client, network server/client status in connected IP address, send/receive frame rate and other values.
Service port to be used for shared server is configured from ‘Config | Shared Server’ menu.
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<Figure 8- 6> Dialog box to view shared server status

8.3.3 Configuration Settings Menu
	Configuration menu items of the program consist of submenus in Database, Config Excel Path, and Shared Server as shown in <Figure 8-7>.
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<Figure 8- 7> Configuration menu items


8.3.3.1 Database

Config | Database menu consists of Connection String, and Save Lists.
1) Connection String XE " Connection String" 
Connection Strings is a configuration required for storing monitored data to database or to view as Excel format reports.
Select Config | Database | Connection String menu for a configuration dialog box as in <Figure 8-8> where connection string which can be used for ‘saving to database’ functionality or others can be added, modified and/or deleted.
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<Figure 8- 8> Dialog box for database connection string configuration 
Selecting [image: image454.png]Add.
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 buttons from <Figure 8-8> prompts a dialog box shown as <Figure 8-9>, where Connection String can be added or modified.
Select [image: image456.png]Delete



 from <Figure 8-8> in order to delete a specific Connection String.
For Connection String to be entered in <Figure 8-9>, please refer to the Connection String example figure or database manuals of the DB vendors.
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<Figure 8- 9> Dialog box to manage DSN
2) Saved lists  XE " Saved lists " 
Saved Lists is a configuration designed for storing monitored data into the database in the predefined time interval.
Select Config | Database | Save Lists menu for a dialog box shown as in <Figure 8-10>.
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<Figure 8- 10> Dialog box to configure database save list 
Selecting [image: image459.png]Add.
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 buttons from <Figure 8-10> prompts a dialog box shown as <Figure 8-11>, where save lists can be added or modified.
Select [image: image461.png]Delete



 from <Figure 8-11> in order to delete a specific list.
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<Figure 8- 11> Dialog box and saved list tab for configuring database saved list 
<Figure 8-11> is a saved list tab for saved list configuration setting dialog box, and the following contents as shown in <Table 8-2> are entered.

	Saved list
	Description

	Title
	Name for saved list is entered using alphabet letters and numbers.

	DSN
	Connection String name configured is entered using the combo box.

	Table
	Table name to store data is entered. 

	Data Cycle
	Storage interval is configured in millisecond units.  Normally 1 minute, or 1 hour is used.

	Use storage timing
	Store data at the time of storage.

Example) Data generated at 1200 are normally stored in 1300 therefore data generated at 1300 are also stored.

	Use duplex server for saving
	In case monitoring/controlling systems are configured in duplex fashion, and there is one database server, only the main server will be handling for storage using this option.

	Relative generation
	Database in the higher time unit of the above configured time interval is relatively generated.

Example)  When the storage interval is set to 1 minute and Relative generation is selected, monitoring data is stored in 1 minute interval and when the storage interval is changed to 1 hour, relative generation table will store data generated in 1 hour.


<Table 8- 2> Elements of the saved list tab of saved list configuration dialog box 

Selecting Date Column tab from saved list configuration settings dialog box will appear a dialog box shown as in <Figure 8-12>.  Enter in date column and MilliSec (Millisecond) column name here.
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<Figure 8- 12> Date column tab from database saved list configuration settings dialog box 
Selecting tag list tab from saved list configuration settings tab will display a dialog box shown as in <Figure 8-13>.
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<Figure 8- 13> Tag list tab of database saved list configuration tab 
Selecting [image: image465.png]Add.



 button from <Figure 8-13> will display tag selection dialog box, here select tags to store to database to add a saved list with the column name from the tag name. Select the added saved list to modify column name, and data type to store where data types include current value(analog, digital), least value(analog), highest value(analog), integration value(analog), average value(analog), on hour(digital), and off hour(digital).
8.3.3.2 Config Excel Path
Excel application path for excel script and reports is configured in Excel path configuration.
Select Config | ‘Config Excel Path’ for a dialog box shown as in <Figure 8-14>.  Enter in the path of excel application executable file from this dialog box.
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<Figure 8- 14> Excel path configuration dialog box 
8.3.3.3 Shared server 
Shared server is a configuration setting used to store current value of the connected systems via network and other values.  Select shared server menu from configuration settings for a dialog box shown in <Figure 8-15> where service port number is entered.

Connection status of the shared server can be viewed from ‘View | Shared Server’ menu.
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<Figure 8- 15> Shared server configuration dialog box 
8.3.4 Help text menu
Help text menu of the program includes help submenu.

Select help submenu to view application program related references.
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Chapter9. Configuration for Web server connection

 XE "Configuration for Web server connection"
Web server is a program which allows monitoring and control of the automated field under inspection through internet and intranet environment.

Network for web server application is composed of a server which provides services, and web client, which connects via internet and intranet for control and monitoring.

Web server connection configurations refer to system configurations of clients, which connect to server for control and monitoring.

※ Note) Usage of web client, which connects to web server for monitoring and control, is similar to other generic monitoring programs.  Please refer to program manual or help contents for detailed usage.

9.1 System requirement 
The system requirements of web client for web server connection is as in the following table <Table 9-1>.

	System   :
	Pentium 4 1.8 or higher, and least 512M of main memory,
storage device with 200M or more space (HDD).

	Operating System   :
	Windows 98/me/2000/XP/Server2003 or newer 
(2000/XP or newer operating system recommended.

	.NET Framework 1.1 or higher

	Microsoft Internet Explorer 6.0 or higher.


<Table 9- 1> System requirement for web client
9.2 Installation of .NET Framework  XE ".Net Framework"
Web server / client is developed using .NET, a new breed of technology from Microsoft, and requires .NET Framework installation (1.1 or higher version) in Windows 98/me/2000/XP/ Server2003 and other newer Windows operating system.  (2000/XP or newer Windows operating system is recommended)

.NET Framework 1.1 installation package can be obtained in following manners.

    ( Free download from Microsoft website.

    ( Download from autobase.biz site.

    ( From the distributed CD in REDIST\DotNetFramework_1_1\dotnetfx.exe.

9.3 Security settings  XE " Security settings "
In order to execute service contents provided by web server, or perform tasks such as monitoring and controlling, registration as an assembly trusted, or a trusted site must be performed.

※ Note) All internet applications running under Microsoft .NET framework require security settings as mandatory.
9.3.1 Registering as a trusted site
In order to register as a trusted site, the following two configurations must be performed.
( .NET Security control

( Register as a trusted sites in Internet Explorer

9.3.1.1 Adjust .NET Security  XE " Adjust .NET Security "
	After Microsoft .NET Framework installation, select Control Panel|Administrative tools (in 98/me, select Programs|Administrative tools) and check for .NET Framework Wizards.
Run .NET Framework Wizards for a window shown as in <Figure 9-1>.
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<Figure 9- 1> .NET Wizards window

	※ Note)
	In case each of the items in <Figure 9-1> are displayed in English, go to Windows Update website, download and install .NET Framework version 1.1 Korean Language Pack’ for Korean menu items.


Select <Figure 9-1> ‘Adjust .NET Security’ for a dialog box as shown in <Figure 9-2>.

Select ‘Make changes to this computer’ in <Figure 9-2> and press [image: image469.png]it >



 button for a dialog box in <Figure 9-3>.
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<Figure 9- 2> Security policy dialog box in Security Adjustment Wizard XE " Security Adjustment "
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<Figure 9- 3> Security Adjustment Wizard dialog box
From Security Adjustment Wizard dialog box in <Figure 9-3>, select ‘Trusted Sites’ and set to ‘Full Trust’ from the level of trust, and select [image: image472.png]it >



 button for a screen similar to <Figure 9-4>.
In a dialog box which displays the configured security level as in <Figure 9-4>, click on [image: image473.png]


 button to complete security adjustment for.NET.
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<Figure 9- 4> Security Adjustment Wizard completion dialog box
9.3.1.2 Register as a Trusted Site in Internet Explorer  XE " Trusted Sites "
After security adjustment is performed with .NET Framework Wizards, run Internet Explorer and select ‘Tools|Internet Options’ for an Internet option configuration dialog box.  Select ‘Security’ tab from Internet Options for a following dialog box <Figure 9-5>.
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<Figure 9- 5> an example of Internet Explorer option dialog box with Security tab on
Select Trusted sites from dialog box in <Figure 9-5> and select [image: image476.png]


 button for a dialog box as shown in <Figure 9-6>.
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<Figure 9- 6> Trusted sites dialog box from Internet Options in Internet Explorer
Enter in the IP address or web site name of desired site from <Figure 9-6> and enter [image: image478.png]


 button for site registration.

※ Note) Generally, when registering as a trusted site from <Figure 9-6>, ‘Require server verification (https:) for all sites in this zone’ ( [image: image479.png][T1Rrequire server verification (https:) For all sites in this zone



 ) should be left unchecked.
9.3.2 Trust an assembly  XE " Trust an assembly "
After Microsoft .NET Framework installation, select Control Panel | Administrative tools (in 98/me, select Programs | Administrative tools) and check for .NET Framework Wizards. Run .NET Framework Wizards for a window shown as in <Figure 9-1>.
Select ‘Trust an assembly’ from <Figure 9-1> for a dialog box as shown in <Figure 9-2>.

Select ‘Make changes to this computer’ in <Figure 9-2> and press [image: image480.png]it >



 button for a dialog box in <Figure 9-7>.
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<Figure 9- 7> Assembly selection dialog box in Trust an Assembly window
Enter in an assembly path or URL from <Figure 9-7> and select [image: image482.png]it >



 button for a dialog box as shown in <Figure 9-8>.

[image: image483.png]Trust an Assembly.

Trust this assembly or all assemblies from this publisher?
The assembly yulve selected has nformalion about the publisher, You can
chaose to st all applications and assemblies fom tha publihe.

o have selcted the follwing assembly:
[Fet7132.166.1. 143 fAutaWebiRunTime Viewtiain.exe

Would you ke to trust:
" This one assembly
3

Publsher

& Al 3355l it The Saime 3ssarbly pUBlE ey
PublcKey Token: [00240000045000004000000060200000024000
¥ Inclide version rumbers  [91.3.0

ht s the diference?





<Figure 9- 8> Assembly selection dialog box

Select ‘Apply to all assemblies sharing a common key’ from <Figure 9-8> and leave ‘Include version number’ unchecked and select [image: image484.png]it >



 button for a dialog box as shown in <Figure 9-9>.  With ‘Include version number’ checked, monitoring/controlling for web client is only available for the selected version.
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<Figure 9- 9> Assembly trust level selection dialog box from Trust an Assembly window 
From <Figure 9-9>, select ‘Trusted Sites’ and set to ‘Full Trust’ from the level of trust, and select [image: image486.png]it >



 button for a screen similar to <Figure 9-10>.
In a dialog box which displays the configured security level as in <Figure 9-10>, click on [image: image487.png]


 button to complete security adjustment for.NET.
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<Figure 9- 10> Trust an Assembly Wizard completion dialog box
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